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About This Guide

This Novell GroupWise 7 Gateway for Microsoft Exchange Installation and Administration Guide 
explains how to install, configure, and run the GroupWise 7 Gateway for Microsoft Exchange. The 
guide is divided into the following sections: 

Chapter 1, “What Is the GroupWise Gateway for Microsoft Exchange?,” on page 11
Chapter 2, “Exchange Gateway System Requirements,” on page 13
Chapter 4, “Installing the Exchange Gateway,” on page 25
Chapter 5, “Configuring the Exchange Side of the Exchange Gateway,” on page 31
Chapter 6, “Configuring the GroupWise Side of the Exchange Gateway,” on page 51
Chapter 7, “Running the Exchange Gateway,” on page 55
Chapter 8, “Configuring the Exchange Gateway,” on page 61
Chapter 9, “Monitoring the Exchange Gateway,” on page 89
Chapter 10, “Optimizing the Exchange Gateway,” on page 103
Chapter 11, “Using Exchange Gateway Startup Switches,” on page 107
Appendix A, “Error and Informational Messages,” on page 117
Appendix B, “Exchange Gateway Directory Structure,” on page 135
Appendix C, “Documentation Updates,” on page 143

Audience

This guide is intended for network administrators who install and administer the GroupWise 
Exchange Gateway.

Feedback

We want to hear your comments and suggestions about this manual and the other documentation 
included with this product. Please use the User Comment feature at the bottom of each page of the 
online documentation, or go to Novell Documentation Feedback (http://www.novell.com/
documentation/feedback.html) and enter your comments there.

Additional Documentation

The GroupWise 7 Gateway for Microsoft Exchange can be used with the following versions of 
GroupWise:

GroupWise 6.5: Novell GroupWise 6.5 Documentation Web site (http://www.novell.com/
documentation/gw65)
GroupWise 7: Novell GroupWise 7 Documentation Web site (http://www.novell.com/
documentation/gw7)
GroupWise 8: GroupWise 8 Documentation Web site (http://www.novell.com/documentation/
gw8)
About This Guide 9

http://www.novell.com/documentation/feedback.html
http://www.novell.com/documentation/gw7
http://www.novell.com/documentation/gw65
http://www.novell.com/documentation/gw8
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The following guides are available for each supported GroupWise version:

Installation Guide
Administration Guide
Multi-System Administration Guide 
Interoperability Guide
Troubleshooting Guides
GroupWise Client User Guides
Wise 7 Gateway for Microsoft Exchange Installation and Administration Guide
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1What Is the GroupWise Gateway 
for Microsoft Exchange?

The GroupWise 7 Gateway for Microsoft Exchange connects a GroupWise system and an Exchange 
system by creating a link between a GroupWise domain and an Exchange server, as shown in the 
following diagram. 

For additional architectural information, see Exchange Gateway Best Practices (http://
www.novell.com/documentation/gwgateways/pdfdoc/best_practices/
Exchange_Gateway_Best_Practices_by_Consultant_Ed_Hanley.pdf) by consultant Ed Hanley.

The GroupWise 7 version of the Exchange Gateway provides the following capabilities:

Message exchange between users of GroupWise 5.x, 6.x, and 7.x and users of Exchange 5.5, 
2000, and 2003.
Directory exchange, so that GroupWise users can be imported into the Exchange Address Book 
and Exchange users can be imported into the GroupWise Address Book. This enables users to 
select recipients from either system in their respective, familiar Address Books.
Directory synchronization, so that when users are added or removed, or user information is 
modified, the changes are automatically replicated between the GroupWise and Exchange 
systems. This keeps the GroupWise and Exchange Address Books up-to-date for all users.
Bi-directional Busy Search (Free/Busy) between GroupWise and Exchange 2000/2003.

1.1  What’s New in This Release
The following enhancements have been added since the previous major release of the Exchange 
Gateway:

The Exchange Gateway has been updated to match GroupWise 6.x and 7.x functionality in 
several areas, including the ConsoleOne snap-ins.
Microsoft Exchange 2000 and 2003 are supported in addition to Exchange 5.5.x.
What Is the GroupWise Gateway for Microsoft Exchange? 11
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The Exchange Gateway can run as a Windows service as well as an application.
You can configure TCP/IP links between the Exchange Gateway and the MTA
Busy Search works for both GroupWise users and Exchange users with Exchange 2000/2003
Internet-style addressing is supported.
SNMP is supported, so that the Exchange Gateway can be monitored from SNMP management 
and monitoring programs.
A Web console is provided, so that the Exchange Gateway can be monitored from any location 
where you have access to a Web browser and the Internet. 
Wise 7 Gateway for Microsoft Exchange Installation and Administration Guide



2
novdocx (en)  16 A

pril 2010
2Exchange Gateway System 
Requirements

The Windows server on which you run the GroupWise 7 Gateway for Microsoft Exchange must 
meet the following system requirements.

Although the GroupWise 7 Gateway for Microsoft Exchange is based on GroupWise 7 functionality, 
it can connect your Exchange system to GroupWise 6.5, GroupWise 7.x, and GroupWise 8.x 
systems.

Hardware/Software Minimum 
Requirements Recommended Requirements

Computer Pentium Pentium II or better

Windows NT Server (for use with Microsoft 
Exchange 5.5)

Updated with 
Service Pack 6

Updated with Service Pack 6 or later

Windows Server 2000 (for use with 
Microsoft Exchange 5.5)

Updated with 
Service Pack 2

Updated with Service Pack 3 or later

Windows Server 2000 with Active Directory 
and the NNTP Service (for use with 
Microsoft Exchange 2000)

Updated with 
Service Pack 2

Updated with Service Pack 3 or later

Windows Server 2003 with Active Directory 
and the NNTP Service (for use with 
Microsoft Exchange 2003)

Updated with 
Service Pack 1

Updated with Service Pack 1 or later

NOTE: The GroupWise 7 Gateway for 
Microsoft Exchange is not yet supported on 
Exchange 2007. However, it can be set up 
successfully on an intermediate Exchange 
2003 server between Exchange 2007 and 
GroupWise. 

Novell Client

NOTE: The Novell Client is required only on 
the Exchange Server for running the 
Exchange Gateway Installation program.

Any version Latest version

ConsoleOne 1.3.6 Latest version

Available Disk Space 80 MB 80 MB or more

Available Memory 32 MB 64 MB or more

Exchange Server 5.5 5.5 updated with Service Pack 1 or 
later; 2000/2003

GroupWise client 6.5 6.5 or later
Exchange Gateway System Requirements 13



14 Group

novdocx (en)  16 A
pril 2010
Wise 7 Gateway for Microsoft Exchange Installation and Administration Guide



3
novdocx (en)  16 A

pril 2010
3Planning the Exchange Gateway 
Installation

Before installing the Exchange Gateway, you should complete the planning tasks listed below. The 
planning tasks provide concepts and information you need as you install and set up the Exchange 
Gateway. You can use the Section 3.10, “Exchange Gateway Installation Worksheet,” on page 21 to 
record your installation and setup information.

Section 3.1, “Gathering GroupWise System Information,” on page 15
Section 3.2, “Deciding Where to Install the Exchange Gateway,” on page 15
Section 3.3, “Choosing a Gateway Name,” on page 16
Section 3.4, “Deciding between Windows Application and Windows Service,” on page 16
Section 3.5, “Deciding How to Monitor the Exchange Gateway,” on page 17
Section 3.6, “Gathering Exchange System Information,” on page 18
Section 3.7, “Determining Connections between Systems,” on page 19
Section 3.8, “Selecting User Address Type and Format,” on page 19
Section 3.9, “Determining Where to Install the Exchange Gateway Administrator Snap-In to 
ConsoleOne,” on page 20
Section 3.10, “Exchange Gateway Installation Worksheet,” on page 21

3.1  Gathering GroupWise System Information
The Exchange Gateway needs to access the GroupWise domain where you want to link the gateway 
into your GroupWise system. You might want to create a new domain specifically for the Exchange 
Gateway. This keeps Exchange Gateway activity separate from domains where post offices are 
located. If you create a new domain, you might want to create it on the Exchange server to minimize 
network traffic.

3.2  Deciding Where to Install the Exchange 
Gateway
You can install the Exchange Gateway on the same server with the domain that the gateway belongs 
to, if that domain is located on Windows. You can also install the Exchange Gateway on a separate 
server, regardless of where the domain is located. The server where you install the Exchange 
Gateway must be an Exchange server.

EXCHANGE GATEWAY INSTALLATION WORKSHEET

Under Item 4: eDirectory Information, list the Novell eDirectory™ tree and context where the Domain 
object is located. 

Under Item 5: GroupWise Domain Information, list the domain name and domain directory. If you want 
to use a separate domain for the Exchange Gateway, create the new domain now.
Planning the Exchange Gateway Installation 15



16 Group

novdocx (en)  16 A
pril 2010
If you install the Exchange Gateway on a different server from where the domain is located, you 
must provide a username and password for the gateway to use when logging in to the server where 
the domain is located. If the domain directory is on a NetWare server, use an eDirectory username 
and password. If the domain directory is on a Windows server, use a Windows username and 
password. The gateway user requires Read, Write, Create, Erase, Modify, and File Scan rights in the 
domain directory.

You might want to set up a new Exchange server with no mailboxes specifically for running the 
Exchange Gateway. In addition, you might want to create a new domain on the new Exchange server 
specifically for housing the Exchange gateway. This configuration facilitates location communicate 
among Exchange, GroupWise, and the Exchange Gateway.

3.3  Choosing a Gateway Name
When you install the Exchange Gateway, a Gateway object is created in the domain where you 
install the gateway. The default gateway name is exchange.

When you install the Exchange Gateway, a subdirectory for the gateway software and queues is 
created under the domain directory. By default, the directory name is the same as the object name. If 
you use the default object name of Exchange, the gateway subdirectory is 
domain\wpgate\exchange.

3.4  Deciding between Windows Application and 
Windows Service
You can install the Exchange Gateway as a Windows application or a Windows service. 

When you install the Exchange Gateway as an application, it can be manually started by a user or it 
can be added to a user’s Startup folder so that it starts automatically when the user logs in to the 
Windows server. When running as an application, the Exchange Gateway displays a console on the 
Windows server where you can monitor and control the gateway.

EXCHANGE GATEWAY INSTALLATION WORKSHEET

Under Item 1: Exchange Gateway Location, mark whether you want to install the Exchange Gateway 
on the same server where the domain is located or on a remote server. For a remote server location, 
specify a username and password to provide login and access rights.

Under Item 3: Domain Server Type, mark whether the domain that owns the Exchange Gateway 
resides on a NetWare® or a Windows server. 

The owning domain cannot reside on a Linux server, but the Exchange Gateway can still service 
domains that reside on Linux servers by way of TCP/IP links.

EXCHANGE GATEWAY INSTALLATION WORKSHEET

Under Item 6: Gateway Details, specify the name you want to use for the Exchange Gateway object in 
the GroupWise system.
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When you install the Exchange Gateway as a service, it can be configured to start automatically 
when the server starts and must run under a specific Windows user account that has rights to run 
services. By default, when running as a service, the Exchange Gateway does not display a user 
interface on the Windows server. However, it can still be monitored from its Web console, as 
described in Section 9.2, “Using the Exchange Gateway Web Console,” on page 92.

If you want to run the Exchange Gateway as a service and if the domain it belongs to is on a 
NetWare server (worksheet item 3), you must create an eDirectory account with a username and 
password that match the Windows user account. The eDirectory user must have Read, Write, 
Compare, Edit, Modify, and File Scan rights to the domain\wpgate\exchange directory. 

3.5  Deciding How to Monitor the Exchange 
Gateway
If you install the Exchange Gateway as an application, the Exchange Gateway server console is 
displayed on the Windows server where the Exchange Gateway is running, which allows you to 
monitor the Exchange Gateway from that location. If you install the Exchange Gateway as a service, 
the Exchange Gateway server console is not displayed, so you must plan to monitor it some other 
way.

Section 3.5.1, “Using the Exchange Gateway Web Console,” on page 17
Section 3.5.2, “Using an SNMP Monitoring Program,” on page 17

3.5.1  Using the Exchange Gateway Web Console
The Exchange Gateway Web console enables you to monitor and control the Exchange Gateway 
from any location where you have access to a Web browser and the Internet. This provides 
substantially more flexible access than the Exchange Gateway server console or an SNMP 
monitoring program.

3.5.2  Using an SNMP Monitoring Program
If desired, you can monitor the Exchange Gateway from Novell ZENworks® for Servers or any 
other SNMP management and monitoring program. When properly configured, the Exchange 
Gateway sends SNMP traps to network management consoles for display along with other SNMP 
monitored programs.

EXCHANGE GATEWAY INSTALLATION WORKSHEET

Under Item 8: Gateway Installation Method, mark whether you want to install and run the Exchange 
Gateway as an application or service. If you want to install it as a service, provide a username and 
password of the Windows account that you want to own the service. 

If the user account does not yet exist, create the user account now and give the account rights to run 
services.

EXCHANGE GATEWAY INSTALLATION WORKSHEET

Under Item 7: Monitoring Options, mark Exchange Gateway Web console. After installing the 
Exchange Gateway, follow the instructions in Section 9.2, “Using the Exchange Gateway Web 
Console,” on page 92 to set up the Exchange Gateway Web console.
Planning the Exchange Gateway Installation 17
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You must enable SNMP during gateway installation. You cannot add this functionality after 

installation. In order for the option to be offered during installation, the Windows server where you 
install the gateway must have the SNMP service installed.

The SNMP service is usually not included during the initial Windows operating system installation. 
To add or configure the SNMP service on the server where you plan to install and run the Exchange 
Gateway, you must be logged in as a member of the Administrator group.

To add the SNMP service to a Windows NT server:

1 From the Control Panel, double-click Network.
2 Click Services, click Add, then select SNMP Service.
3 Follow the on-screen prompts. You need your original Windows NT media.

You are given the opportunity to configure the SNMP service. The only required information 
for the Exchange Gateway is the Trap Destination and Community Name fields.

4 After the installation is complete, reboot the Windows NT server.
For more information about configuring the SNMP service, see your Windows NT 
documentation. 

To add the SNMP service to a Windows 2000/2003 server:

1 From the Control Panel, double-click Add/Remove Programs.
2 Click Add/Remove Windows Components.
3 Select Management and Monitoring Tools.
4 Click Details, then select Simple Network Management Protocol.
5 After the installation is complete, reboot the Windows server.

For more information about configuring the SNMP service, see your Windows documentation. 

3.6  Gathering Exchange System Information
If you are using Exchange 5.5, you must know the name of the Exchange 5.5 site where you want to 
create the Exchange mailbox through which messages will flow to and from the GroupWise system.

If you are using Exchange 2000/2003, you must know the name of the Exchange server, along with 
the name of the mailbox store where you want to create the Exchange mailbox and the name of the 
storage group where the mailbox store is located. You must also know the administrative group and 
routing group that the server belongs to.

In either case, you must have a list of all servers in your Exchange system. The Exchange Gateway 
needs to be installed on only one Exchange server, but the addressing components must be installed 
on all Exchange servers. The addressing components generate GroupWise-type addresses for 
Exchange users.

EXCHANGE GATEWAY INSTALLATION WORKSHEET

Under Item 9: Enable SNMP?, mark whether you want to configure the Exchange Gateway for SNMP.
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3.7  Determining Connections between Systems
To facilitate addressing of messages between systems, you must set up a representation of the 
Exchange system in your GroupWise system and a connector to your GroupWise system in your 
Exchange system. 

In GroupWise, non-GroupWise systems are represented by non-GroupWise domains. When you 
first start the Exchange Gateway, the non-GroupWise domain for the Exchange system is created 
automatically. By default, it is named after the Exchange organization. Under the non-GroupWise 
domain for the Exchange system, an external post office is automatically created for the Exchange 
site or administrative group on the Exchange server. By default, it is given the same name as the 
Exchange site or administrative group. If necessary, you can specify different names for the non-
GroupWise domain and external post office. 

In Exchange, non-Exchange systems link to the Exchange system through connectors. On the 
Exchange side, you might want to call the Exchange Gateway GroupwiseConnector, because it 
connects the Exchange system to GroupWise.

3.8  Selecting User Address Type and Format
By default, every Exchange user will have a GroupWise-type address with the following format:

GWise:domain.post_office.user_ID

GWise is the default Exchange address type created for the GroupWise system. You can change it if 
needed.

EXCHANGE GATEWAY INSTALLATION WORKSHEET

Under Item 2: Exchange Server Information, list the Exchange system information required for your 
version of Exchange.

EXCHANGE GATEWAY INSTALLATION WORKSHEET

Under Item 12: Non-GroupWise Domain, mark whether you want to use the default name (the 
Exchange organization) or specify a name for the non-GroupWise domain.

Under Item 13: External Post Office, mark whether you want to use the default name (the Exchange 
site or administrative group) or specify a name for the external post office.

EXCHANGE GATEWAY INSTALLATION WORKSHEET

Under Item 6: Gateway Details, specify the name you want to use in Exchange to represent the link to 
the GroupWise system.

EXCHANGE GATEWAY INSTALLATION WORKSHEET

Under Item 11: GroupWise Address Type in Exchange System, mark whether you want to use the 
default address type (GWise) or specify the address type name you want to use.
Planning the Exchange Gateway Installation 19
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Exchange user addresses are generated automatically when you start the Exchange Gateway, using 
the format shown above. As described earlier, the Installation program maps the name of the 
Exchange organization to the GroupWise domain portion of the address, the name of the Exchange 
site or administrative group on the server to the post office portion of the address, and the Exchange 
user mailbox name to the GroupWise user ID portion of the address.

The recommendation is to use Exchange mailbox names as GroupWise user IDs. However, if this is 
not possible for some reason, the following variables can be used to specify the information you 
want to appear in the GroupWise user IDs:

Preferably, the GroupWise user IDs should include the Exchange mailbox names along with 
whatever other information you want to provide. For example, “%m_%d” would create GroupWise 
user IDs that consist of the Exchange mailbox names and users’ display names.

3.9  Determining Where to Install the Exchange 
Gateway Administrator Snap-In to ConsoleOne
Exchange Gateway administration is performed through ConsoleOne, version 1.3.6 or later. When 
you install the Exchange Gateway, the Gateway Administrator snap-in files can be copied to a 
ConsoleOne location that you specify. The Gateway Administrator snap-in files extend the 
functionality of ConsoleOne to let you administer the Exchange Gateway. 

You must install the Gateway Administrator snap-in files to an installation of ConsoleOne where the 
GroupWise Administrator snap-ins have already been installed. You need to know whether you are 
installing it along with the GroupWise 6.5 or GroupWise 7.x Administrator snap-ins.

If you want to install the Gateway Administrator snap-in at the same time when you install the 
Exchange Gateway, the ConsoleOne installation must be accessible from the Exchange server where 
you are installing the gateway. You can install the Gateway Administrator snap-in to additional 
locations after you have installed the Exchange Gateway, as described in Section 4.5, “Installing the 
Exchange Gateway Administrator Snap-In to ConsoleOne,” on page 29.

Variable Description

%m Mailbox name (default)

%s Surname

%g Given name

%d Display name

%r char1 char2 Replace char1 with char2

%% Per cent sign character

EXCHANGE GATEWAY INSTALLATION WORKSHEET

Under Item 14: Exchange User Address Format, mark whether you want to use the default GroupWise 
user ID format (Exchange mailbox name) or specify the format you want to use.
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3.10  Exchange Gateway Installation Worksheet

EXCHANGE GATEWAY INSTALLATION WORKSHEET

Under Item 9: Install Gateway Administrator Snap-In to ConsoleOne, specify the path for the 
ConsoleOne location you want to use to administer the Exchange Gateway and the version of the 
GroupWise Administrator snap-ins that are already in use.

Item Explanation

1) Exchange Gateway Location:

Domain server

Remote server

Username

Password

Mark whether you want to install the Exchange Gateway on the 
same server with the GroupWise domain it belongs to, or on a 
remote server. 

For access to a remote server, provide a username and password 
to facilitate logging in with the required rights. 

See Section 3.2, “Deciding Where to Install the Exchange 
Gateway,” on page 15.

2) Exchange Server Information:

Exchange 5.5 Server:

Site

Exchange 2000/2003 Server:

Administrative Group

Routing Group

Exchange Server

Storage Group

Mailbox Store

Servers in Your Exchange System:

Provide the required information for your version of the Exchange 
server, along with a list of all servers in your Exchange system.

See “Gathering Exchange System Information” on page 18.

3) Domain Server Type:

NetWare

Windows

Mark the platform of the server where the gateway’s domain is 
located. 

See “Gathering GroupWise System Information” on page 15.

4) eDirectory Information:

Tree

Domain Object Context

Specify the eDirectory tree and context where the Domain object is 
located. The Exchange Gateway object will be created in the 
Domain object. 

See “Gathering GroupWise System Information” on page 15

5) GroupWise Domain Information:

Domain Name

Domain Directory

Specify the domain name and directory. The Exchange Gateway 
will be installed in a subdirectory under the domain. 

See “Gathering GroupWise System Information” on page 15
Planning the Exchange Gateway Installation 21



22 Group

novdocx (en)  16 A
pril 2010
6) Gateway Details:

Gateway Object Name on 
Exchange Server

Gateway Object Name in 
GroupWise System

Gateway Directory

Specify the name of the Exchange Gateway object in the Exchange 
system and in the GroupWise system, as well as the subdirectory in 
the domain where the Exchange Gateway software will be installed. 
The default is Exchange.

See “Choosing a Gateway Name” on page 16

7) Monitoring Options:

Exchange Gateway Web 
console

SNMP monitoring program

Mark how you want to monitor the Exchange Gateway. 

See “Deciding How to Monitor the Exchange Gateway” on page 17.

8) Gateway Installation Method:

Application

Service

User

Password

Mark whether you want to install the Exchange Gateway as a 
Windows application or a Windows service. 

If you want to install it as a service, provide a username and 
password of the Windows account that will own the service. 

See “Deciding between Windows Application and Windows 
Service” on page 16. 

9) Install Gateway Administrator 
Snap-In to ConsoleOne?

Yes

ConsoleOne path

GroupWise Administrator 
snap-in version: 6.5 / 7.x

No

Mark whether you want to install the Exchange Gateway 
Administrator snap-in to ConsoleOne at the same time when you 
install the Exchange Gateway. If you do, record the path where 
ConsoleOne and the GroupWise Administrator snap-ins to 
ConsoleOne are currently installed and the version of the 
GroupWise Administrator snap-ins.

See “Determining Where to Install the Exchange Gateway 
Administrator Snap-In to ConsoleOne” on page 20.

10) Enable SNMP?

Yes

No

Mark whether you want to enable SNMP. 

See “Deciding How to Monitor the Exchange Gateway” on page 17.

11) GroupWise Address Type in 
Exchange System:

GWise (default)

Custom

Mark whether you want to use the default address type of GWise or 
a custom address type. If you do not want to use GWise, specify 
the address type you want to use for addressing messages to 
GroupWise users.

See Section 3.8, “Selecting User Address Type and Format,” on 
page 19

12) Non-GroupWise Domain:

Exchange organization 
(default)

Custom

Mark whether you want to use the name of the Exchange 
organization as the name of the non-GroupWise domain that 
represents the Exchange system in GroupWise. If you do not want 
to use the default, specify the name for the non-GroupWise 
domain.

See “Determining Connections between Systems” on page 19.

Item Explanation
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13) External Post Office:

Exchange site or 
administrative group (default)

Custom

Mark whether you want to use the name of the Exchange site or 
administrative group as the name of the external post office that 
represents the collection of Exchange users on the server where 
you are installing the Exchange Gateway. If you do not want to use 
the default, specify the name for the external post office.

See “Determining Connections between Systems” on page 19.

14) Exchange User Address 
Format

Exchange mailbox name 
(default)

Custom

Mark whether you want to use the Exchange mailbox name as the 
GroupWise user ID for each Exchange user. 

See Section 3.8, “Selecting User Address Type and Format,” on 
page 19.

Item Explanation
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4Installing the Exchange Gateway 

Before you install the GroupWise 7 Gateway for Microsoft Exchange, both the GroupWise system 
and the Exchange system should be running smoothly. Then complete the following tasks to connect 
the two systems through the Exchange Gateway:

Section 4.1, “Meeting Installation Prerequisites,” on page 25
Section 4.2, “Adding the Exchange Library Directory to the Path Variable,” on page 26
Section 4.3, “Installing the Exchange Gateway Software,” on page 26
Section 4.4, “Installing the Exchange Gateway Addressing Components,” on page 27
Section 4.5, “Installing the Exchange Gateway Administrator Snap-In to ConsoleOne,” on 
page 29

4.1  Meeting Installation Prerequisites
After you have gathered the information that the Exchange Gateway Installation program requires 
and have planned the information you need to configure the Exchange Gateway after installation, 
make sure that the Windows server where you plan to install the Exchange Gateway meets the 
system requirements listed in Chapter 2, “Exchange Gateway System Requirements,” on page 13.

1 Make sure that the Novell Client™ is installed on the Exchange server where you run the 
Installation program.
The Installation program creates a Gateway object in eDirectory. The Novell Client is required 
to access eDirectory. If necessary, you can download the Novell Client from the Novell Product 
Downloads site (http://download.novell.com).

IMPORTANT: The Novell Client is not required on other Exchange servers where you install 
the Exchange Gateway Addressing Components.

2 Make sure that ConsoleOne is installed, along with the GroupWise Administrator snap-ins.
ConsoleOne and the GroupWise Administrator snap-ins are available on your GroupWise 
Administrator CD.

3 Log in to the server where the domain directory resides and map a drive to the domain directory 
(worksheet item 5). 
The Installation program creates domain subdirectories and copies Exchange Gateway files to 
the subdirectories under the domain. This requires full file system rights to the domain 
directory. 

IMPORTANT: The owning domain cannot reside on a Linux server, but the Exchange 
Gateway can still service domains that reside on Linux servers by way of TCP/IP links.

4 Log in to eDirectory with Admin-equivalent rights to the eDirectory tree where the Domain 
object resides (worksheet item 4).
The Installation program creates a Gateway object under the Domain object.

5 Continue with Adding the Exchange Library Directory to the Path Variable.
Installing the Exchange Gateway 25
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4.2  Adding the Exchange Library Directory to the 
Path Variable
The Exchange Gateway Installation program needs to be able to locate the Exchange software 
library directory. The Installation program adds the default location (c:\program 
files\exchsrvr\bin) to the end of the path variable. If you have installed Exchange in another 
location, you must manually add the Exchange software library directory to the path variable on the 
server where the Exchange Gateway runs.

1 Right-click My Computer, then click Properties.
2 Click Advanced > Environment Variables.
3 In the User Variables for Administrator list, add the Exchange software library directory to the 

end of the path variable value.
If one of the directory names in the path includes a space, use one of the following formats for 
your software library directory:
"c:\program files\exchsrvr\bin"
c:\progra~1\exchsrvr\bin

4 Click Set, then click OK.
5 Continue with Installing the Exchange Gateway Software.

4.3  Installing the Exchange Gateway Software
1 Download the GroupWise Gateway for Microsoft Exchange from the Novell Product 

Downloads site (http://download.novell.com) into an empty directory on the server where you 
want to install it (worksheet item 1).
The server where you install the Exchange Gateway must be an Exchange server.

2 Run setupexch701.exe to extract the Exchange Gateway files into the directory.
3 Run install.exe to start the Exchange Gateway Installation program on the Exchange server.
Wise 7 Gateway for Microsoft Exchange Installation and Administration Guide
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If the Installation program does not start automatically, run install.exe in the directory 
where you extracted the Exchange Gateway files.

4 Click Next to view the license agreement, then click Accept to accept the license agreement.

5 Select Install Gateway and Addressing Components, then click Next.
6 Follow the prompts, using the information from items 2 through 9 on the Section 3.10, 

“Exchange Gateway Installation Worksheet,” on page 21 to install the Exchange Gateway

IMPORTANT: Do not start the Exchange Gateway after installation.

7 If your Exchange system consists of more than one server, continue with Section 4.4, 
“Installing the Exchange Gateway Addressing Components,” on page 27.

8 Continue with Configuring the Exchange Side of the Exchange Gateway.

4.4  Installing the Exchange Gateway Addressing 
Components
When you installed the Exchange Gateway, the Installation program automatically generated 
GroupWise-type addresses for all Exchange users on that server. If your Exchange system consists 
of multiple servers, you must install the Exchange Gateway addressing components on each server.

1 Plan the addressing format you want to use for users on the new server, as described in 
“Determining Connections between Systems” on page 19 and Section 3.8, “Selecting User 
Address Type and Format,” on page 19. 

2 If you are going to use customized address format, stop the Exchange Gateway.
3 At each Exchange server, run setupexch700.exe to start the Installation program.
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If the Installation program does not start it automatically, run install.exe in the directory 
where you extracted the Exchange Gateway files.

4 Click Next to view the license agreement, then click Accept to accept the license agreement.

5 Select Install Addressing Components.
6 Click Next to continue with the installation.

The Installation program installs the gwproxy.dll file on each Exchange server.
7 Follow the instructions in “Configuring the Exchange Side of the Exchange Gateway” on 

page 31 to prepare the Exchange server to connect to the original Exchange server where the 
gateway is installed.

8 Skip to Chapter 7, “Running the Exchange Gateway,” on page 55.
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4.5  Installing the Exchange Gateway 
Administrator Snap-In to ConsoleOne
After you have installed the Exchange Gateway, you can install the Exchange Gateway 
Administrator snap-in to Console One to additional locations as needed. 

1 Run setupexch701.exe to extract the Exchange Gateway files into a directory on the 
workstation or server where you want to install the Exchange Gateway Administrator snap-in 
to ConsoleOne.

2 Make sure that no one is running ConsoleOne where you want to install the Gateway 
Administrator snap-in.

3 Run install.exe in the directory where you extracted the Exchange Gateway files to start the 
Exchange Gateway Installation program.

4 Click Next to view the license agreement, then click Accept to accept the license agreement.
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5 Select Install Gateway Administrator Snap-Ins for ConsoleOne Only.
6 Click Next to continue with the installation.
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5Configuring the Exchange Side of 
the Exchange Gateway

After you install the Exchange Gateway software but before you start the Exchange Gateway for the 
first time, you must prepare your Exchange system to link to your GroupWise system:

Section 5.1, “Configuring Exchange 5.5,” on page 31
Section 5.2, “Configuring Exchange 2000/2003,” on page 34

5.1  Configuring Exchange 5.5
1 Start Exchange Administrator.

2 Expand the Exchange site, expand the Configuration container, then select the Connections 
container.

3 Double-click the Exchange Gateway object (worksheet item 6), then click Export Containers.
Configuring the Exchange Side of the Exchange Gateway 31



32 Group

novdocx (en)  16 A
pril 2010
4 Select the Recipient containers that contain users whose Address Book information you want to 
export into the GroupWise system, then click Add.

5 In the Trust Level field, select a trust level number that is larger than the trust level numbers of 
the users you want to export.

IMPORTANT: Directory synchronization and exchange cannot occur if the trust level of one 
or more gateway users is less than that of the Gateway object.

6 Click OK to save the Exchange user export information.
When GroupWise users are imported into the Exchange system, they are, by default, placed in 
a container named GroupWise at the root of Active Directory. You can use the /
useimportcontainer gateway startup switch to place the users into the import container 
specified under Administrative Groups > First Administrative Group > Routing Group > First 
Routing Group > Connectors > Exchange Gateway Connector.

7 Make sure that the Exchange services are running.
7a On the Control Panel, double-click Services.
7b Scroll down to check the status of the following services:

Microsoft Exchange Directory
Microsoft Exchange Event Service
Microsoft Exchange Information Store
Microsoft Exchange Message Transfer Agent
Microsoft Exchange System Attendant

7c If any of the Microsoft Exchange services are not running, start them now.
8 If you want to customize the name of the non-GroupWise domain that represents the Exchange 

system, the external post office that represents the Exchange site, or the format of GroupWise-
type usernames for Exchange users, continue with Section 5.1.1, “Customizing Addressing for 
Exchange 5.5,” on page 33.
or
Skip to Chapter 6, “Configuring the GroupWise Side of the Exchange Gateway,” on page 51
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5.1.1  Customizing Addressing for Exchange 5.5
1 In Exchange Administrator, expand the Site container, then select the Configuration container.

2 Double-click the Site Addressing object, then click the Site Addressing tab.

If no GroupWise-specific address type appears in the list, then the addressing components have 
not been installed on the server. See Section 4.4, “Installing the Exchange Gateway Addressing 
Components,” on page 27.

3 Select GWISE (or your custom address type for GroupWise), then click Edit.
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4 To change the name of the non-GroupWise domain that you want to represent your Exchange 
system, replace the Exchange organization with the domain name you want to use (worksheet 
item 12).

5 To change the name of the external post office, replace the Exchange site with the post office 
name you want to use (worksheet item 13).

6 To change the format of the GroupWise usernames that will be generated for Exchange users, 
specify the desired address format (worksheet item 14).

7 Click OK to save the addressing information.
8 Back on the Site Addressing tab, click OK.
9 Skip to Chapter 6, “Configuring the GroupWise Side of the Exchange Gateway,” on page 51.

5.2  Configuring Exchange 2000/2003
Section 5.2.1, “Performing Basic Configuration for Exchange 2000/2003,” on page 34
Section 5.2.2, “Setting Up Bidirectional Busy Search for Exchange 2000/2003,” on page 39
Section 5.2.3, “Customizing Addressing for Exchange 2000/2003,” on page 48

NOTE: The Exchange System Manager interface is different in Windows 2000 and Windows 2003, 
but the same steps can be performed in both Windows versions.

5.2.1  Performing Basic Configuration for Exchange 2000/2003
1 Start Exchange System Manager. 
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TIP: If you do not see the Administrative Groups object, right-click the Organization object, 
then click Properties. Select Display Administrative Groups and Display Routing Groups, then 
click OK.

2 Expand Administrative Groups, then expand First Administrative Group (or whatever your 
system’s administrative group is).

3 Expand Routing Groups, then expand First Routing Group (or whatever your system’s routing 
group is).

4 Expand Connectors, right-click the Gateway object, then click Properties.
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5 Click Modify, specify the administrator username and password, then click OK.
6 Click Export Containers.

7 Click Add, select the container that contains Exchange users whose addresses and information 
you want to export to the GroupWise system (for example, the Users container), then click OK 
to add the export container to the list.

IMPORTANT: Directory synchronization and exchange cannot occur if you have not added 
any user containers to the Export Containers property page.
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When GroupWise users are imported into the Exchange system, they are, by default, placed in 
a container named GroupWise at the root of Active Directory. You can use the /
useimportcontainer gateway startup switch to place the users into the import container 
specified under Administrative Groups > First Administrative Group > Routing Group > First 
Routing Group > Connectors > Exchange Gateway Connector.

8 Click OK again to return to the main Exchange System Manager window.

9 Expand Servers, then expand the Server object for your server.

10 Expand First Storage Group (or whatever your system’s storage group is).
11 Right-click Mailbox Store, click Properties, then click Security.
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12 Add the user to log in to the Exchange services and the Windows server (if the user has not 
been added already). 

13 Scroll to the bottom of the Permissions list, grant the user Send As and Receive As permissions, 
then click OK.
Make sure that the permissions are explicitly granted, not inherited through a parent security 
object. If necessary, click Advanced to verify the permissions.

14 Make sure that the Exchange services are running.
14a On the Control Panel, double-click Services.
14b Scroll down to check the status of the following services:

Microsoft Exchange Event
Microsoft Exchange IMAP4
Microsoft Exchange Information Store
Microsoft Exchange Management
Microsoft Exchange MTA Stacks
Microsoft Exchange POP3
Microsoft Exchange Routing Engine
Microsoft Exchange Site Replication Service
Microsoft Exchange System Attendant

14c If any of the Microsoft Exchange services are not running, start them now.
Make sure that the Startup Type field for each service is set to Automatic so that you do 
not need to start them manually in the future.

15 If you want to set up bidirectional Busy Search between the GroupWise and Exchange systems, 
continue with Setting Up Bidirectional Busy Search for Exchange 2000/2003.
or
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If you want to customize the name of the non-GroupWise domain that represents the Exchange 
system, the external post office that represents the Exchange administrative group, or the 
format of GroupWise-type usernames for Exchange users, skip to Section 5.2.3, “Customizing 
Addressing for Exchange 2000/2003,” on page 48.
or
Skip to Chapter 6, “Configuring the GroupWise Side of the Exchange Gateway,” on page 51

5.2.2  Setting Up Bidirectional Busy Search for Exchange 2000/
2003
After performing basic configuration of the Exchange Gateway, you can configure it so that both 
GroupWise users and Exchange users can perform Busy Searches on each other.

“Setting Up the Microsoft Calendar Connector on Exchange 2000” on page 39
“Setting Up the Microsoft Calendar Connector on Exchange 2003” on page 42
“Checking GroupWise-Related Windows Services” on page 46
“Resynchronizing Users” on page 47
“Testing the Bidirectional Busy Search” on page 48

NOTE: Bidirectional busy search is not available for Exchange 5.5.

Setting Up the Microsoft Calendar Connector on Exchange 2000

“Installing the Calendar Connector on Exchange 2000” on page 39
“Configuring the Calendar Connector on Exchange 2000” on page 39

Installing the Calendar Connector on Exchange 2000

For background information about the Exchange 2000 Calendar Connector, see the Microsoft article 
Exchange 2000 Service Pack 1 Calendar Connector (http://support.microsoft.com/kb/278009/).

1 Insert the Microsoft Exchange 2000 Service Pack 1 or later CD into the CD drive on the 
Exchange server.

2 Browse to the \english\exch2000\ent_spn\calcon\i386 directory on the CD, then run 
setup.exe.

3 When the Setup program appears, click Next.
4 Select Full installation including required Schema updates, then click Next.
5 When the installation is complete, click OK.
6 Continue with Configuring the Calendar Connector on Exchange 2000.

Configuring the Calendar Connector on Exchange 2000

1 In Exchange System Manager, expand Administrative Groups > First Administrative Group > 
Routing Groups > First Routing Group > Connectors.
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2 Right-click the Calendar Connector, then click Properties.
3 Under Connector used to import users into Active Directory, click Modify.

4 In the Name field, specify the name of the GroupWise Gateway for Microsoft Exchange 
connector, then click OK to display the Calendar Connector Properties dialog box.
Wise 7 Gateway for Microsoft Exchange Installation and Administration Guide



novdocx (en)  16 A
pril 2010
5 Set Maximum age in minutes to 0.
The 0-second setting causes a free/busy request to come through the gateway for every refresh. 
If you change to a larger number, Exchange caches free/busy requests for the specified number 
of minutes.

6 Set Maximum number of seconds to wait to 60.
The 60-second setting prevents the gateway from quitting too soon as it waits for responses.
You can customize these settings as needed for your Exchange system.

7 Click Apply to save your settings.
8 Click Calendar Connections.
9 If there is not a Novell GroupWise type already listed, click New, select Novell GroupWise, 

then click OK to display the GroupWise Calendar Connection dialog box.

10 In the GroupWise API Gateway field, specify domain.exchange_gateway, then click OK.
This provides the name of the Domain object and the name of the Exchange Gateway object.

11 Click Schedule.
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12 Select Always, then click OK.
13 Skip to “Checking GroupWise-Related Windows Services” on page 46.

Setting Up the Microsoft Calendar Connector on Exchange 2003

“Installing the Calendar Connector on Exchange 2003” on page 42
“Deactivating the Microsoft Connector for Novell GroupWise” on page 44
“Configuring the Calendar Connector on Exchange 2003” on page 45

Installing the Calendar Connector on Exchange 2003

1 Insert the Microsoft Exchange 2003 CD into the CD drive on the Exchange server.
2 If the CD autoruns, ignore the installation page that appears.
3 Browse to the \setup\i386 directory on the CD, then run setup.exe.
4 When the Installation Wizard appears, click Next.
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5 Click the check mark in the Action column for Microsoft Exchange, then select Change from 
the drop-down list.

6 Click the check mark in the Action column for Microsoft Exchange Messaging and 
Collaboration Services, then select Change from the drop-down list.

7 Click in the Action column for Microsoft Exchange Connector for Novell GroupWise, then 
select Install.

8 Click in the Action column for Microsoft Exchange Calendar Connector, then select Install.

9 Continue with Deactivating the Microsoft Connector for Novell GroupWise.
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Deactivating the Microsoft Connector for Novell GroupWise

The Exchange Gateway does not use the Connector for Novell GroupWise provided by Microsoft.

1 In Exchange System Manager, expand Administrative Groups > First Administrative Group > 
Routing Groups > First Routing Group > Connectors.

2 Right-click Connector for Novell GroupWise, then click Properties.
3 In the API Gateway Path field, specify a valid path in order to activate the other properties.

The Exchange Gateway does not use the Connector for Novell GroupWise provided by 
Microsoft, so any valid path is sufficient.

4 Click Address Space.

5 Select the GWISE address space, then click Modify.
6 In the Address field, change the address space to NotUsed, then click OK.
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The bidirectional configuration for Busy Search does not use the GWISE address space that is 
set up when you install the Exchange Gateway.

7 Continue with Configuring the Calendar Connector on Exchange 2003.

Configuring the Calendar Connector on Exchange 2003

1 In the Connectors list, right-click Calendar Connector, then click Properties.
2 Under Connector used to import users into Active Directory, click Modify.

3 In the Enter the object name to select field, specify the name of the GroupWise Gateway for 
Microsoft Exchange connector.

4 Click Names to verify that you typed it correctly, then click OK to display the Calendar 
Connector Properties dialog box.

5 Set Maximum age in minutes to 0.
The 0-second setting causes a free/busy request to come through the gateway for every refresh. 
If you change to a larger number, Exchange caches free/busy requests for the specified number 
of minutes.

6 Set Maximum number of seconds to wait to 60.
The 60-second setting prevents the gateway from quitting too soon as it waits for responses.
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You can customize these settings as needed for your Exchange system.
7 Click Apply to save your settings.
8 Click Calendar Connections.
9 If there is not a Novell GroupWise type already listed, click New, select Novell GroupWise, 

then click OK to display the GroupWise Calendar Connection dialog box.

10 In the GroupWise API Gateway field, specify domain.exchange_gateway, then click OK.
This provides the name of the Domain object and the name of the Exchange Gateway object.

11 Click Schedule.

12 Select Always, then click OK.
13 Continue with Checking GroupWise-Related Windows Services.

Checking GroupWise-Related Windows Services

1 On the Windows desktop of the Exchange server, open the Control Panel.
2 Double-click Administrator Tools, then double-click Services.
3 Right-click Microsoft Exchange Connector for Novell GroupWise, then click Properties.
4 If Startup Type is set to Automatic, change it to Manual.

The Microsoft Exchange Connector for Novell GroupWise is no longer needed and should not 
be started when the Windows server restarts.
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5 If the Microsoft Exchange Connector for Novell GroupWise is currently running, click Stop.
6 Click OK to save the new settings for the Microsoft Exchange Connector for Novell 

GroupWise.
7 In the list of services, make sure that the Microsoft Exchange Calendar Connector is running. If 

it is not:
7a Right-click Microsoft Exchange Calendar Connector, then click Properties.
7b In the Startup Type field, select Automatic.
7c Click Start, then click OK.

8 In the list of services, make sure that the Microsoft Exchange Router for Novell GroupWise is 
running. If it is not:
8a Right-click Microsoft Exchange Router for Novell GroupWise, then click Properties.
8b In the Startup Type field, select Automatic.
8c Click Start, then click OK.

9 Click File > Exit to close the Services window.
10 If this is a new installation of the Exchange Gateway, skip to “Testing the Bidirectional Busy 

Search” on page 48.
or
If this is an update installation of the Exchange Gateway, continue with Resynchronizing 
Users.

Resynchronizing Users

If you are updating your Exchange Gateway with Support Pack 1, you need to resynchronize users. 
In order to ensure that the Address Books of both systems are synchronized and contain valid 
addresses, you delete the existing user information so that it is refreshed automatically with the new 
configuration that you have just set up.

1 Delete the GroupWise users that currently display in the Exchange Address Book.
1a Start Active Directory Users and Computers.
1b Expand the Exchange server object.
1c Click the GroupWise folder.
1d Delete all the users from the folder.

2 Delete the Exchange users that currently display in the GroupWise Address Book.
2a In the GroupWise View in ConsoleOne, select Users in the drop-down list at the top of the 

window.
2b Expand the External Domain object that contains the representation of your Exchange 

system.
2c Select an External Post Office object that represents an Exchange site or administrative 

group of your Exchange system to display the users in that post office.
2d Delete all the users, then delete the External Post Office object.
2e Repeat Step 2c and Step 2d for each External Post Office object.
2f Delete the External Domain object.
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3 Make sure that directory synchronization is enabled.
3a Browse to and right-click the Exchange Gateway object, then click Properties.
3b Click GroupWise > Optional Gateway Settings. 
3c Make sure that Directory Sync/Exchange is set to Both.

4 Start the Exchange Gateway, as described in Section 7.1, “Starting the Exchange Gateway,” on 
page 55.
A fresh user synchronization automatically takes places between the two systems and 
bidirectional Busy Search is now available.

5 Continue with Testing the Bidirectional Busy Search.

Testing the Bidirectional Busy Search

1 Start Outlook.
2 Create a new meeting request for a GroupWise user.
3 Click Attendee Availability in the new meeting request.

You should see the schedule of the GroupWise user.
4 Select a time, then send the meeting request to the GroupWise user.
5 In the GroupWise client of the user to whom you send the meeting request, accept the meeting 

request, then create an appointment for an Outlook user.
6 Click Busy Search in the new appointment.

You should see the schedule of the Outlook user.
7 Select a time, then send the appointment to the Outlook user.

If you can perform these tasks, then bidirectional busy search is set up correctly.
8 If you want to customize the name of the non-GroupWise domain that represents the Exchange 

system, the external post office that represents the Exchange administrative group, or the 
format of GroupWise-type usernames for Exchange users, continue with Customizing 
Addressing for Exchange 2000/2003.
or
Skip to Chapter 6, “Configuring the GroupWise Side of the Exchange Gateway,” on page 51.

5.2.3  Customizing Addressing for Exchange 2000/2003
1 In Exchange System Manager, expand the Recipients container, then select the Recipient 

Policies container.
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2 Right-click the Default Policy object, click Properties, then click the E-Mail Addresses 
(Policy) tab.

If no GroupWise-specific address type appears in the list, then the addressing components have 
not been installed on the server. See Section 4.4, “Installing the Exchange Gateway Addressing 
Components,” on page 27.

3 Select GWISE (or your custom address type for GroupWise), then click Edit.
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In the Address field, the three parts of a GroupWise address (domain, post office, and 
username) are separated by periods. The displayed default is 
Exchange_organization.Exchange_administrative_group.address_format_variable.

4 To change the name of the non-GroupWise domain that you want to represent your Exchange 
system, replace the Exchange organization with the domain name you want to use worksheet 
item 12).

5 To change the name of the external post office, replace the Exchange administrative group with 
the post office name you want to use (worksheet item 13).

6 To change the format of the GroupWise usernames that will be generated for Exchange users, 
replace %m with the desired address format (worksheet item 14).

7 Click OK.
8 Back on the Default Policy properties dialog box, click OK again to save the address format, 

then click Yes to update all corresponding recipient e-mail addresses to the specified format.
9 Continue with Chapter 6, “Configuring the GroupWise Side of the Exchange Gateway,” on 

page 51
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6Configuring the GroupWise Side 
of the Exchange Gateway

After you have configured the Exchange side of the gateway, you must configure the GroupWise 
side of the gateway by configuring the Exchange Gateway object in ConsoleOne.

Section 6.1, “Providing Foreign System Configuration Information,” on page 51
Section 6.2, “Providing Gateway Information,” on page 52

6.1  Providing Foreign System Configuration 
Information

1 In ConsoleOne, connect to the domain where you installed the Exchange Gateway (worksheet 
item 4), then select the Domain object.

2 Right-click the Exchange Gateway object, then click Properties.

3 On the Foreign System Configuration page, click Default to populate the fields.

NOTE: If the Foreign System Configuration page is not available, then the Exchange Gateway 
snap-in is not installed in ConsoleOne.
Configuring the GroupWise Side of the Exchange Gateway 51



52 Group

novdocx (en)  16 A
pril 2010
The defaults are typically acceptable, but you can change the information if needed.
Address:  Specify the name of the Exchange address type (worksheet item 11) that you want 
the gateway to create in the Exchange system. The default is GWise.
Administrator:  Specify the name and e-mail address of the administrator of the Exchange 
system.
Converters:  The locations of the conversion DLLs is provided automatically.

IMPORTANT: We highly recommend that you do not change the default information.

4 Click Apply to save the foreign system configuration information.
5 Continue with Section 6.2, “Providing Gateway Information,” on page 52.

6.2  Providing Gateway Information
1 On the Exchange Gateway object, click GroupWise > Identification.
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2 Fill in the following fields on the Identification page:
Description:  This field is optional. If desired, provide any descriptive information about the 
gateway.
Subdirectory:  Displays the name of the Exchange Gateway root directory specified during 
installation. The default is exchange.
Time Zone:  Displays the time zone of the domain where the gateway is installed.
Database Version:  Select 6.5 or 7.x, depending on the version of your GroupWise system.
Platform:  Displays Windows as the default platform.
Gateway Type:  Defaults to Exchange.
Gateway Alias Type:  Specify Exchange.

3 Click OK to save the gateway information.
You have now provided sufficient configuration information to start the Exchange Gateway.

4 Continue with “Running the Exchange Gateway” on page 55.
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7Running the Exchange Gateway

After you have installed the Exchange Gateway software and configured both sides of the gateway, 
you are ready to start the gateway.

Section 7.1, “Starting the Exchange Gateway,” on page 55
Section 7.2, “Acquainting E-Mail Users with the Exchange Gateway,” on page 57
Section 7.3, “Stopping the Exchange Gateway,” on page 58
Section 7.4, “Uninstalling the Exchange Gateway,” on page 58

After the Exchange Gateway has started successfully, continue with Chapter 8, “Configuring the 
Exchange Gateway,” on page 61

7.1  Starting the Exchange Gateway
Before you start the Exchange Gateway, make sure that it has network access to the following 
locations:

The GroupWise domain directory and subdirectories where you installed the gateway files. The 
gateway requires Read, Write, Create, Erase, Modify, and File Scan rights.
The Exchange server. You should have already provided access when you configured the 
Exchange side of the gateway, as described in Chapter 5, “Configuring the Exchange Side of 
the Exchange Gateway,” on page 31.

Follow the instructions for the installation method you chose for the Exchange Gateway (worksheet 
item 7):

“Starting the Exchange Gateway As a Windows Application” on page 55
“Starting the Exchange Gateway As a Windows Service” on page 56

IMPORTANT: After you start the gateway, stop and then start the MTAs in the GroupWise system. 
This establishes the links to the non-GroupWise domain that represents the Exchange system.

7.1.1  Starting the Exchange Gateway As a Windows 
Application

1 At the Windows server where you installed the Exchange Gateway, click Start > Programs.
2 Click GroupWise Exchange Gateway > Exchange > GroupWise Exchange Gateway. 
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When running as an application, the Exchange Gateway server console appears on the server 
while it is running. For instructions on interpreting the information displayed on the Exchange 
Gateway server console, and for information about other monitoring alternatives, see 
Chapter 9, “Monitoring the Exchange Gateway,” on page 89.

3 Stop and then start the MTAs in the GroupWise system.
This establishes the links to the non-GroupWise domain that represents the Exchange system.

4 After the Exchange Gateway has started successfully and the links between systems have been 
established, skip to Chapter 8, “Configuring the Exchange Gateway,” on page 61.

7.1.2  Starting the Exchange Gateway As a Windows Service
1 At the Windows server where you installed the Exchange Gateway, click Start > Settings > 

Control Panel.
2 Double-click Services.

In the alphabetical list of services, the name of the Exchange Gateway service starts with the 
name of the domain where the gateway is installed, followed by the name of the gateway itself, 
followed by Service. For example, if the domain is named Connector and the gateway is named 
Exchange, then the name of the service is ConnectorExchangeService.

3 Select the gateway service, then click Start.
When running as a service, the Exchange Gateway does not have a console on the server where 
it is running. However, you can monitor it in other ways, as described in Chapter 9, 
“Monitoring the Exchange Gateway,” on page 89.

4 Stop and then start the MTAs in the GroupWise system.
This establishes the links to the non-GroupWise domain that represents the Exchange system.

5 After the Exchange Gateway has started successfully and the links between systems have been 
established, skip to Chapter 8, “Configuring the Exchange Gateway,” on page 61.
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7.2  Acquainting E-Mail Users with the Exchange 
Gateway
After you have started the Exchange Gateway, GroupWise users and Exchange users need only the 
following information in order to start using the gateway immediately:

Section 7.2.1, “Addressing Messages,” on page 57
Section 7.2.2, “Understanding What GroupWise Send Options Are Available through the 
Gateway,” on page 57

7.2.1  Addressing Messages
If you plan to set up directory synchronization and exchange, as described in Section 8.1, “Enabling 
Directory Synchronization and Exchange of Address Books,” on page 61, GroupWise users can 
select Exchange users from the GroupWise Address Book, and Exchange users can select 
GroupWise users from the Exchange Address Book.

If you do not plan to set up directory synchronization and exchange, you must explain to GroupWise 
users how to add Exchange users to their personal address books, as described in “Adding Individual 
Exchange Users to Personal Address Books” on page 66. You must also explain to both GroupWise 
users and Exchange users how to manually type addresses in the To field of messages.

7.2.2  Understanding What GroupWise Send Options Are 
Available through the Gateway
GroupWise users can use some, but not all, GroupWise send options through the Exchange 
Gateway. The following GroupWise send options are supported:

Priority (high, normal, low)
Classification (normal, proprietary, confidential, secret, top secret, for your eyes only)
Reply Requested (when convenient or within x days)
Delay Delivery (deliver item after x days)
Notify Recipients (if enabled as described in Section 8.7, “Enabling Message Status for Sent 
Items,” on page 85)

GroupWise to 
Exchange 

Syntax 

gateway_name:exchange_organization.exchange_site.recipient’s_mailboxt_name

Examples 

Exchange:XYZCorp.Provo.SJones

Exchange to 
GroupWise 

Syntax 

address_type:domain.post_office.user_ID

Examples 

GWise:Corporate.Marketing.LTanaka
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The following GroupWise send options are not supported:

Expiration Date (after x days)
Auto-Delete (when the last recipient has deleted the message)
Conceal Subject
Require Password to Complete Routed Item
Sign Digitally
Encrypt for Recipients

7.3  Stopping the Exchange Gateway
Occasionally, it might be necessary to stop the gateway to perform maintenance on the Windows 
server or for some other purpose. When you stop the gateway, any messages being sent from 
GroupWise users are queued in one of the domain\wpgate\exchange\wpcsout\ngaxxxx\0-7 
directories. Messages sent from Exchange users are moved to the gateway’s mail store. The 
messages waiting in each system are processed as soon as the gateway is started again.

Follow the instructions for the installation option you chose for the Exchange Gateway:

Section 7.3.1, “Stopping the Exchange Gateway If It Is Running As an Application,” on 
page 58
Section 7.3.2, “Stopping the Exchange Gateway If It Is Running As a Service,” on page 58

7.3.1  Stopping the Exchange Gateway If It Is Running As an 
Application

1 At the Exchange Gateway server console, click File > Exit.
or
Press F7.

2 Click Yes to stop the gateway.

7.3.2  Stopping the Exchange Gateway If It Is Running As a 
Service

1 At the Exchange Gateway server console, click Start > Settings > Control Panel.
2 Double-click Services.
3 Select the Exchange Gateway service, then click Stop.

Recall that the Exchange Gateway Service is named after the domain and gateway.

7.4  Uninstalling the Exchange Gateway
If you need to remove the Exchange Gateway from the server where you installed it, follow the 
instructions for the installation option you chose when installing the Exchange Gateway:

Section 7.4.1, “Uninstalling the Exchange Gateway As an Application,” on page 59
Section 7.4.2, “Uninstalling the Exchange Gateway As a Service,” on page 59
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7.4.1  Uninstalling the Exchange Gateway As an Application
1 At the Windows server where you installed the Exchange Gateway, click Start > Programs > 

GroupWise Exchange Gateway > Exchange > Uninstall.
2 If a message informs you that some files could not be deleted, delete the 

domain\wpgate\exchange directory.
3 In ConsoleOne, delete the Exchange Gateway object from the domain.

7.4.2  Uninstalling the Exchange Gateway As a Service
1 At the Windows server where you installed the Exchange Gateway, click Start > Settings > 

Control Panel.
2 Double-click Add/Remove Programs, select domain.gateway (Exchange Gateway), then click 

OK.
3 If a message informs you that some files could not be deleted, delete the 

domain\wpgate\exchange directory.
4 In ConsoleOne, delete the Exchange Gateway object from the domain.
Running the Exchange Gateway 59



60 Group

novdocx (en)  16 A
pril 2010
Wise 7 Gateway for Microsoft Exchange Installation and Administration Guide



8
novdocx (en)  16 A

pril 2010
8Configuring the Exchange 
Gateway

After the Exchange Gateway is up and running between the GroupWise system and the Exchange 
system, there are a variety of ways to refine its configuration to meet the specific needs of your e-
mail users.

Section 8.1, “Enabling Directory Synchronization and Exchange of Address Books,” on 
page 61
Section 8.2, “Configuring Addressing Instead of Using Directory Synchronization and 
Exchange,” on page 64
Section 8.3, “Changing the Link Protocol between the Exchange Gateway and the MTA,” on 
page 72
Section 8.4, “Controlling Gateway Access,” on page 73
Section 8.5, “Setting Up Accounting,” on page 81
Section 8.6, “Establishing Gateway Administrators,” on page 84
Section 8.7, “Enabling Message Status for Sent Items,” on page 85
Section 8.8, “Binding the Exchange Gateway to a Specific IP Address,” on page 86

8.1  Enabling Directory Synchronization and 
Exchange of Address Books
Directory synchronization and exchange enable the Exchange Gateway to automatically exchange 
Address Book information between the GroupWise system and the Exchange system. 

Directory Exchange:  Causes the gateway to perform a nightly exchange of the Exchange 
public Address Book and GroupWise Address Book.
Directory Synchronization:  Causes the gateway to update each Address Book as changes in 
Address Book information occur. If directory synchronization is not enabled, the Address 
Books are not updated until the nightly directory exchange occurs.

IMPORTANT: To ensure proper replication of names and addresses in both systems, use both 
directory synchronization and exchange.

1 Make sure that the Exchange system is set up to support directory synchronization and 
exchange, as described in Chapter 5, “Configuring the Exchange Side of the Exchange 
Gateway,” on page 31. You might want to double-check the trust level established for the 
gateway.

2 If you have domains in your GroupWise system that contain users that you do not want to 
appear in the Exchange version of the GroupWise Address Book, use the /blockdom switch in 
the startup files (gwexch.cfg) to list the GroupWise domains that should not be included in the 
directory synchronization and exchange process.
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3 In ConsoleOne, browse to and select the domain where you installed the Exchange Gateway, 
right-click the Exchange Gateway object, then click Properties to display the gateway 
Identification page.

4 Click GroupWise > Optional Gateway Settings to display the Optional Gateway Settings page.

5 In the Directory Sync/Exchange field, select Both, then click OK.
ConsoleOne passes the directory synchronization and exchange information to the Exchange 
Gateway so that it can start transferring user information. The larger the Address Books are, the 
longer the process takes.

6 If you want the names of GroupWise users to display as Lastname, Firstname in the Exchange 
Address Book, add the /displaynamelastfirst gateway startup switch to the gwexch.cfg file.

7 If you edited the gwexch.cfg file, stop and then start the Exchange Gateway so that it reads the 
updated startup file.

When you first started the Exchange Gateway, a non-GroupWise domain representing the Exchange 
system was created automatically. It was named after the Exchange organization. Under the non-
GroupWise domain, an external post office was created for each Exchange site or server and given 
the same name as the corresponding Exchange site or server. However, no user information was 
transferred at that time.

Now that you have enabled directory synchronization and exchange, Exchange users are added to 
these external post offices as external GroupWise users.

You can see the results of directory synchronization and exchange in the following locations:

Exchange users appear in ConsoleOne because External User objects are created in the 
External Post Office object that represents the Exchange site or administrative group.
Wise 7 Gateway for Microsoft Exchange Installation and Administration Guide



novdocx (en)  16 A
pril 2010
Exchange users appear in the GroupWise Address Book because they have External User 
objects in the GroupWise system.
GroupWise users appear in the Exchange Address Book because the Exchange Gateway 
creates recipient addresses based on the GroupWise address type, as described in Section 3.8, 
“Selecting User Address Type and Format,” on page 19.

When you first turn on directory synchronization and exchange, e-mail addresses from the Exchange 
system come into the GroupWise Address Book in the format 
username.administrative_group.exchange_organization. You can configure the non-GroupWise 
domain that represents the Exchange system to format e-mail addresses in a more familiar manner.

1 In ConsoleOne, browse to and right-click the Non-GroupWise Domain object that represents 
your Exchange system, then click Properties.

2 Click GroupWise > Internet Addressing.

3 Select Override next to the Internet Domain Name field, then specify the Internet domain name 
for your Exchange system (such as example.com).

4 Select Override next to the Preferred Address Format field, then select the address format that 
your users are accustomed to.
After the specified Internet domain name and address format have replicated throughout the 
GroupWise system, users’ e-mail addresses display as desired in the GroupWise Address 
Book.

Related Startup Switches You can use the /allowdom and /blockdom startup switches in the 
Exchange Gateway startup file (gwexch.cfg) to control which GroupWise domains have their users 
displayed in the Exchange Address Book.

Exchange Gateway Web Console You can see whether directory synchronization and exchange 
are enabled on the Configuration page. You can turn directory synchronization and exchange on and 
off for the current gateway session on the Optional Gateway Settings page.
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8.2  Configuring Addressing Instead of Using 
Directory Synchronization and Exchange
When you take advantage of directory synchronization and exchange, as described in Section 8.1, 
“Enabling Directory Synchronization and Exchange of Address Books,” on page 61, GroupWise 
users and Exchange users can select each other out of their familiar Address Books. Addressing is 
not an issue under these circumstances.

If you do not want to enable directory synchronization and exchange, you must use other addressing 
alternatives:

Section 8.2.1, “Adding Individual Exchange Users to the GroupWise Address Book,” on 
page 64
Section 8.2.2, “Adding Individual Exchange Users to Personal Address Books,” on page 66
Section 8.2.3, “Adding Individual GroupWise Users to the Exchange Address Book,” on 
page 67
Section 8.2.4, “Using Explicit Addressing,” on page 71
Section 8.2.5, “Setting Up an Addressing Rule to Facilitate Busy Searches,” on page 71

8.2.1  Adding Individual Exchange Users to the GroupWise 
Address Book
If there are some specific Exchange users who you want to appear in the GroupWise Address Book, 
you can add those individual users without enabling directory synchronization and exchange. You 
add Exchange users to the GroupWise Address Book by defining them as external users and then 
specifying the explicit addresses required to route messages to them in the Exchange system.

1 In ConsoleOne, select GroupWise System, select the non-GroupWise domain that represents 
the Exchange system, then select the external post office that represents the Exchange site or 
administrative group where the Exchange user is located.

2 Right-click the GroupWise Post Office object that represents the Exchange site or 
administrative group, then click New > External User.

3 Type a username, then click OK.
4 Right-click the new External User object, then click Properties.
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5 Fill in fields as needed to provide information about Exchange the user that you want to appear 
in the GroupWise Address Book.

6 Click Apply to save the user information.
7 Click GroupWise > Gateway Aliases to display the Gateway Aliases page.

You use the Gateway Aliases page to define the explicit address required to route messages to 
the user in the Exchange system.

8 Click Add to display the Create Alias dialog box.
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9 Fill in the following fields:
Gateway Alias Type:  From the list, select the Exchange Gateway.
The gateway alias type was defined during configuration of the gateway. If there is no gateway 
alias type listed for the gateway, you can define one now. See Section 6.2, “Providing Gateway 
Information,” on page 52.
Gateway Alias:  Specify the user’s address as defined in Exchange.
For an example, see “Addressing Messages” on page 57.

10 Click OK to save the gateway alias and return to the Gateway Alias page.
The gateway alias is now listed in the Gateway Alias list.

11 Click OK to save the list.
ConsoleOne passes the alias information to the Exchange Gateway so that the Exchange user is 
added to the GroupWise Address Book.

12 Repeat Step 2 through Step 11 for each Exchange user you want to add to the GroupWise 
Address Book.

8.2.2  Adding Individual Exchange Users to Personal Address 
Books
GroupWise users can also add Exchange users to their personal address books if the Exchange users 
are not already defined in the GroupWise Address Book. 

1 In the GroupWise Windows client, click Tools > Address Book to open the Address Book.
2 Select a personal address book.
3 Click New > Contact > OK.
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4 Fill in the following fields:
First:  Specify the user’s first name.
Last:  Specify the user’s last name.
E-mail Address:  Specify the explicit address required to route a message to the Exchange 
user. For syntax and examples, see “Addressing Messages” on page 57.

5 Click OK to save the new contact in the personal address book.

8.2.3  Adding Individual GroupWise Users to the Exchange 
Address Book
If there are some specific GroupWise users who you want to appear in the Exchange Address Book, 
you can add those individual users without enabling directory synchronization and exchange. You 
add GroupWise users to the Exchange Address Book by defining them as custom recipients and then 
specifying the explicit addresses required to route messages to them in the GroupWise system. You 
can also configure the Exchange Gateway to perform directory synchronization and exchange for 
them.

“Adding GroupWise Users in Exchange 5.5” on page 67
“Adding GroupWise Users in Exchange 2000/2003” on page 69
“Including Custom Users in Directory Synchronization” on page 71

Adding GroupWise Users in Exchange 5.5

1 Start Exchange Administrator.
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2 Expand the Recipients container.
3 Select an existing container.

or
Create a new container for GroupWise recipients.
3a Click File > New Other > Recipients Container.
3b Specify a name for the new container; for example, GroupWise Recipients.
3c Specify a directory for the new container.
3d Click OK.

4 Select the container in which you want to create a custom recipient to represent a GroupWise 
user, then click File > New Custom Recipient.

5 Select GWISE Address, then click OK.
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6 In the Display Name field, specify the full name of the GroupWise user.
7 In the Address field, specify the GroupWise user’s address in the following format:

domain.post_office.user_ID
where domain is the name of the GroupWise domain, post_office is the name of the GroupWise 
post office, and user_ID is the user’s GroupWise ID.

8 Click OK.
9 In the Properties dialog box, specify whatever information you want to be available about the 

GroupWise user, then click OK.
The GroupWise user can now be selected from the Exchange Address Book.

Adding GroupWise Users in Exchange 2000/2003

1 On the Windows desktop, click Programs > Microsoft Exchange > Active Directory Users and 
Computers.

2 Expand the Users container, select the container in which you want to create a Contact, then 
click Action > New > Contact.
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3 Specify the information about the GroupWise user that you want to be available in the 
Exchange Address Book, then click Next.

4 In the E-mail Address field, click Modify.

5 Select Novell GroupWise Address, then click OK.
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6 In the Address field, specify the GroupWise user’s address in the following format:
domain.post_office.user_ID
where domain is the name of the GroupWise domain, post_office is the name of the GroupWise 
post office, and user_ID is the user’s GroupWise ID.

7 Click OK, click Next, then click Finish.
The GroupWise user can now be selected from the Exchange Address Book.

Including Custom Users in Directory Synchronization

If you want to be able to change user information associated with custom recipients in Exchange and 
have the information for the corresponding GroupWise user updated to match, you must enable 
directory synchronization for custom recipients. In the Exchange Gateway startup file 
(gwexch.cfg), use the /custom startup switch to enable directory synchronization for custom 
recipients. For more information about directory synchronization, see Section 8.1, “Enabling 
Directory Synchronization and Exchange of Address Books,” on page 61.

8.2.4  Using Explicit Addressing
If you do not enable directory synchronization and exchange, and if users are not represented in the 
other e-mail system’s Address Book, then users on both sides of the gateway must use explicit 
addressing. See “Addressing Messages” on page 57.

8.2.5  Setting Up an Addressing Rule to Facilitate Busy 
Searches
When performing a busy search, the Exchange server uses LDAP to identify the users being 
searched, rather than the typical recipient information used when delivering messages. If users’ e-
mail addresses do not match their mailbox names, messages are delivered successfully but busy 
searches fail. 

You can use the /addressrule startup switch in the gwexch.cfg file to define the format you want the 
gateway to use when it sends a busy search request to the Exchange system. With the /addressrule 
startup switch, you can use the following tags to specify the address format you want:

<domain>
<username>
<firstname>
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<lastname>
<firstinitial>
<lastinitial>

Each tag is replaced with the corresponding user-specific information. Additional text can be added 
to the address format as well.

Examples: 

/addressrule-<firstname>_<lastname>@<domain>
/addressrule-<firstname>.<lastname>@<domain>
/addressrule-<username>@exchange.<domain>

These address rules would result in the following addresses for a user named Sophie Jones at 
Corporate.com:

Sophie_Jones@Corporate.com
Sophie.Jones@Corporate.com
SJones@exchange.Corporate.com

8.3  Changing the Link Protocol between the 
Exchange Gateway and the MTA
Before the GroupWise 7 Gateway for Microsoft Exchange, the Exchange Gateway and the MTA 
communicated by transferring message files through message queue directories using a mapped/
UNC link. Starting with the GroupWise 7 version of the gateway, you can configure the gateway so 
that it uses a TCP/IP link to communicate with the MTA, instead of transferring message files 
through queue directories. During installation, the Exchange Gateway is configured for a mapped/
UNC link. You can reconfigure it to use a TCP/IP link in ConsoleOne®.

1 In ConsoleOne, right-click the Exchange Gateway object, then click Properties.
2 Click GroupWise > Network Address.
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3 In the TCP/IP Address field, click Edit, specify the IP address or DNS hostname of the server 
where the Exchange Gateway is running (which is not necessarily the server where the 
Exchange Gateway software is installed), then click OK to return to the Network Address page.

4 In the Message Transfer Port field, specify a unique port number; for example, 7103.
5 Click OK to save the new link configuration for the Exchange Gateway.

ConsoleOne then notifies the Exchange Gateway and the MTA to restart using the new link 
protocol.

8.4  Controlling Gateway Access
The Exchange Gateway lets you control access through the gateway. For example, you can:

Control which GroupWise users can send messages and to which Exchange users
Control which GroupWise users can receive messages and from which Exchange users
Control the maximum size for messages sent through the gateway
Control whether or not rule-generated GroupWise messages are sent through the gateway

The standard way to control access for all GroupWise and Exchange users on the GroupWise side of 
the gateway is with the access.cfg file in the domain\wpgate\exchange directory. In addition, 
you can control individual user access using the Gateway Access field of individual User objects in 
ConsoleOne.

Section 8.4.1, “Using the Access.cfg File in the Gateway Directory,” on page 74
Section 8.4.2, “Using the Gateway Access Field on Individual User Objects,” on page 79

On the Exchange side of the gateway, access control is provided on the Permissions page of the Site 
Addressing object. See your Exchange documentation for more information.
Configuring the Exchange Gateway 73



74 Group

novdocx (en)  16 A
pril 2010
8.4.1  Using the Access.cfg File in the Gateway Directory
The access.cfg file is an ASCII text file that can be edited with a standard text editor. It is located 
in the gateway root directory (for example, domain\wpgate\exchange). The access.cfg file 
enables you to implement the following specific types of access control:

Provide specific access control based on GroupWise domains and post offices
Provide specific access control based on access groups that you define
Limit the size of incoming and outgoing messages to and from your GroupWise system for 
specific domains, post offices, or access groups
Prevent messages from specific addresses from entering your GroupWise system for specific 
domains, post offices, or access groups
Allow messages from specified addresses to enter your GroupWise system, while preventing 
all others for specific domains, post offices, or access groups
Prevent rule-generated messages from going out of your GroupWise system for specific 
domains, post offices, or access groups

The initial access.cfg file includes descriptions and examples of the section headers and keywords 
that you can use in the file. However, all lines are initially commented out and access control is off 
by default. Print the initial access.cfg file in the domain\wpgate\exchange directory. Reviewing 
the file can help you understand how it works.

Add the following line at the top of the file to turn on access control:

Access Control=On

After access control has been turned on, you can create sections in the access.cfg file for various 
groups of users. Section headers are enclosed in square brackets ([header]). Within each section, 
you use keywords to define the access control settings for the group to which the section applies. 
The following section headers and keywords are available:

Section headers, keywords, and settings are not case sensitive. The In and Out directions are from 
the point of view of the GroupWise system. Semicolons (;), slashes (/), and pound signs (#) can be 
used to comment out lines of text. In the examples provided in the access.cfg file, the string 
gwaddresstext represents the address of an Exchange user. For example, you could replace 
gwaddresstext with Novell.Sales.Glen if that is the appropriate address format, as explained in 
Section 3.8, “Selecting User Address Type and Format,” on page 19.

Exchange Gateway Web Console You can turn access control on and off for the current gateway 
session on the Access Control page. You can also adjust the maximum message size.

Section Headers Keywords

[Default:In|Out]
[groupwise_domain:In|Out]
[groupwise_domain.post_office:In|Out]
[AccessGroup:group_name]

AllAccess
NoAccess
Block
Allow
MaxSize
AllowRuleGenerated
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Section Headers

Section headers establish groups of users to which access control settings are applied.

“[Default:In|Out]” on page 75
“[groupwise_domain:In|Out]” on page 75
“[groupwise_domain.post_office:In|Out]” on page 75
“[AccessGroup:group_name]” on page 76

[Default:In|Out]

This section lists the access control settings for users who are not covered by access control settings 
for a particular GroupWise domain, post office, or access group.

Syntax: 

[Default:In]
[Default:Out]

Examples: 

[Default:In]
MaxSize=100000
[Default:Out]
AllowRuleGenerated=No

This example limits incoming messages to 100 KB but does not limit the size of outgoing messages. 
It prevents rule-generated GroupWise messages from transferring through the gateway to the 
Exchange system. These access control settings would apply to any users who did not fall under a 
more specific section header.

[groupwise_domain:In|Out]

This section lists the access control settings for users in a particular GroupWise domain.

Syntax: 

[groupwise_domain:In]
[groupwise_domain:Out]

Examples: 

[Corporate:In]
MaxSize=100000000
[Corporate:Out]
AllowRuleGenerated=Yes

This example limits incoming messages to 1 MB but does not limit outgoing messages. It allows 
GroupWise users to send rule-generated messages.

[groupwise_domain.post_office:In|Out]

This section lists the access control settings for users in a particular GroupWise post office.
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Syntax: 

[groupwise_domain.post_office:In]
[groupwise_domain.post_office:Out]

Examples: 

[Corporate.Temps:In]
Allow NetTech
MaxSize=10000
[Corporate.Temps:Out]
Allow NetTech
MaxSize=10000
AllowRuleGenerated=No

This example allows users in the Temps post office to exchange messages with users in the 
Exchange NetTech system only. It restricts incoming and outgoing messages to 10 KB. It prevents 
rule-generated messages.

[AccessGroup:group_name]

This section lists the access control settings for individual GroupWise users who are assigned to the 
access group in ConsoleOne, as described in “Using the Gateway Access Field on Individual User 
Objects” on page 79. Access groups do not have direction parameters. If you want to control access 
in both directions, you must create separate access groups.

Syntax:[ 

[AccessGroup:group_name]

Examples: 

[AccessGroup:SysAdminsIn]
MaxSize=5000000[
[AccessGroup:SysAdminsOut]
AllowRuleGenerated=Yes

This example allows users in the SysAdminsIn and SysAdminsOut access groups to receive 
messages up to 5 MB in size and to send rule-generated messages. 

Keywords

Keywords define the access control settings for the users included under each section header.

“AllAccess” on page 77
“NoAccess” on page 77
“Block” on page 77
“Allow” on page 78
“MaxSize” on page 78
“AllowRuleGenerated” on page 79
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AllAccess

This keyword provides unrestricted access to the Exchange Gateway for those GroupWise users 
specified by the section header. Users can send messages to or receive messages from Exchange 
users, depending on the direction specified by the header.

Examples: 

[Corporate.Executives:In]
AllAccess[
[Corporate.Executives:Out]
AllAccess

This example allows all GroupWise users in the Executives post office to exchange messages with 
all Exchange users with no access control restrictions.

NoAccess

This keyword restricts access to the Exchange Gateway for those GroupWise users specified by the 
section header. Users cannot send or receive messages through the gateway, depending on the 
direction specified in the header.

Examples: 

[Corporate.Temps:In]
NoAccess
[Corporate.Temps:Out]
NoAccess

This example prevents all GroupWise users in the Temps post office from exchanging messages 
with Exchange users.

Block

This keyword restricts access to the Exchange Gateway from the perspective of Exchange users. 
This keyword differs from NoAccess because a specific Exchange address must be provided. If 
GroupWise users try to send mail to a Exchange address that has been blocked, they receive a 
message from the gateway stating that the message is undeliverable.

Syntax: 

Block exchange_server
Block username@exchange_server
Block CN=full_name/O=organization@exchange_server

Examples: 

[Corporate.Temps:In]
Block XYZCorp
[Corporate.Temps:Out]
Block XYZCorp

[Corporate.Executives:In]
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Block SJones@XYZCorp
Block CN=Sophie Jones/O=Sales@XYZCorp

The first example prevents GroupWise users in the Temps post office from exchanging messages 
with users in the Exchange XYZCorp system. The second example prevents GroupWise users in the 
Executives post office from receiving messages from a specific Exchange user. Providing the 
username in both formats is required to totally block a user.

Allow

This keyword allows messages to pass through the Exchange Gateway only if the message’s 
recipient matches the Exchange address specified on the Allow line. Any messages addressed to 
other Exchange addresses are blocked.

Syntax: 

Allow exchange_server
Allow username@exchange_server
Allow CN=full_name/O=organization@exchange_server

Examples: 

[Corporate.Temps:In]
Allow NetTech
[Corporate.Temps:Out]
Allow NetTech

[Default:In]
Allow SJones@XYZCorp
Allow CN=Sophie Jones/O=Sales@XYZCorp

The first example allows GroupWise users in the Temps post office to exchange messages with the 
NetTech Exchange system but no others. The second example allows all users to receive messages 
from a specified user. 

MaxSize

This keyword determines the maximum size of messages that the Exchange Gateway can transfer 
between systems. Maxsize is specified in bytes (1000 = 1000 bytes or 1 KB), with a range from 0 to 
2147483647.

Unless you have a reason to limit the message size (for example, you are charged for the amount of 
data transferred by the gateway), you might not want to limit the message size. When attachments 
are encoded as they pass through the gateway, they generally become larger.

Syntax: 

Maxsize=number_of_bytes

Examples: 

[Corporate.Temps:In]
MaxSize=1000000
Wise 7 Gateway for Microsoft Exchange Installation and Administration Guide



novdocx (en)  16 A
pril 2010
[Corporate.Temps:Out]
MaxSize=5000000

This example prevents GroupWise users in the Temps post office from receiving messages larger 
than 1 MB and from sending messages larger than 5 MB.

AllowRuleGenerated

This keyword determines whether or not rule-generated messages are allowed through the Exchange 
Gateway. It applies only to outbound messages from GroupWise to Exchange.

You could use this keyword to control rule-generated messages such as “On Vacation” from 
entering the Exchange system. Unlike NoAccess and Block, the gateway does not generate a status 
message stating that the mail message was undeliverable. Instead, the message remains pending in 
the sender’s mailbox.

Syntax: 

AllowRuleGenerated=Yes | No

Examples: 

[Default:Out]
AllowRuleGenerated=No

This example prevents all rule-generated messages from transferring from the GroupWise system to 
the Exchange system.

8.4.2  Using the Gateway Access Field on Individual User 
Objects
You can use the Gateway Access field on the GroupWise Account page of each User object in 
ConsoleOne to control individual user access. This can be useful if you only have a few users whose 
access you want to control. If you have many users whose access you want to control, you should 
use the access.cfg file, as described in “Using the Access.cfg File in the Gateway Directory” on 
page 74.

1 If desired, create an access control group in the access.cfg file.
2 In ConsoleOne, browse to and right-click the user whose access you want to control, then click 

Properties.
3 Click GroupWise > Account to display the Account page.
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4 Fill in the Gateway Access field. 
If you created an access control group in the access.cfg file in Step 1, specify the name of the 
access control group that you want this user to be associated with.
If you have not created an access control group, you can put access control information unique 
to this user in the Gateway Access field.

       Syntax: 
gateway.direction:keyword,keyword,...,keyword;gateway.direction:keyword,...,keyword

The following keywords are valid in the Gateway Access field:
AllAccess
NoAccess
MaxSize
AllowRuleGenerated

IMPORTANT: The Block and Allow keywords cannot be used in the Gateway Access field. 
They can only be used in the access.cfg file.

        Example: 
Exchange.Out:MaxSize=500000,AllowRuleGenerated=No;Exchange.In:Maxsize=50000

In this example, the gateway name is Exchange, the maximum message size is 500 KB, and 
rule-generated messages are prevented from leaving the GroupWise system. The gateway 
direction designations and their keywords are separated by a semicolon (;).

5 Click OK to save the access control information for the selected user.
ConsoleOne passes the access control information to the Exchange Gateway so that the access 
control settings are in force immediately.
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8.5  Setting Up Accounting
Every day at midnight, the Exchange Gateway creates an accounting file (acct) in the 
domain\wpgate\exchange\000.prc directory. The acct file is an ASCII-delimited text file that 
records the source, priority, message type, destination, and size of each item passing through the 
gateway. 

Section 8.5.1, “Enabling Accounting,” on page 81
Section 8.5.2, “Defining an Accountant,” on page 81
Section 8.5.3, “Understanding the Accounting File,” on page 82

8.5.1  Enabling Accounting
1 In ConsoleOne, browse to and right-click the Exchange Gateway object, then click Properties.
2 Click GroupWise > Optional Gateway Settings to display the Optional Gateway Settings page.

3 Make sure Accounting is set to Yes.
4 Click Apply to save your changes.
5 Continue with “Defining an Accountant” on page 81.

Exchange Gateway Web Console You can turn accounting on and off for the current gateway 
session on the Optional Gateway Settings page.

8.5.2  Defining an Accountant
1 On the Exchange Gateway object, click GroupWise > Gateway Administrators to display the 

Gateway Administrators page.
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The Gateway Administrators page lets you select a GroupWise user to be the Accountant for 
the Exchange Gateway. Each night at midnight, the gateway mails the accounting file (acct) to 
the Accountant.

2 Click Add to open the Select GroupWise Object dialog box, then select a user to function as the 
Accountant for the Exchange Gateway.
You can also select multiple users and/or distribution lists in the Select GroupWise Object 
dialog box.

3 Click OK to return to the Gateway Administrators page.
4 In the Administrators list, select the user or distribution list that you want to function as the 

Accountant.
In the Administrators list, you can also select multiple users and distribution lists as needed.

5 In the Administrator Role box, select Accountant.
6 Click OK to save the changes.

ConsoleOne passes the accounting information to the Exchange Gateway so that the 
Accountant can begin receiving daily accounting files.

7 Continue with “Understanding the Accounting File” on page 82.

8.5.3  Understanding the Accounting File
The accounting file (acct) is an ASCII-delimited text file that records the source, priority, message 
type, destination, and other information about each message sent through the gateway. The file, 
which is updated daily at midnight, is located in the domain\wpgate\exchange\000.prc 
directory. If no Accountant is defined to receive the file, the file is deleted each day.

A sample line from an accounting file is shown below:
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O,05/18/05, 20:42:55,,
Mail,3,Corporate,Temps,LTanaka,,Reminder,Connector,Exchange,,
Mail,SJones@Provo,1,0,2593

Each item sent through the gateway is recorded on a separate line, with the fields separated by 
commas. Two or more commas in a row indicate that a field has no data. The following table 
describes the fields in the order in which they are found in the accounting file.

The acct file can be imported into a word processor, spreadsheet, or database program for further 
analysis.

Field Description Example

In/Out Status Indicates if the message is outbound (O) or inbound (I) O

Message Date The date when the message was sent 5/18/06

Message Time The time when the message was sent 20:42:55

GroupWIse Message ID A set of numbers that uniquely identifies the message 
in the GroupWise system

3F429BA6.961 : 
12 : 31746

GroupWise Message 
Type

Type of item sent or received Mail

GroupWise Message 
Priority

0 = High, 2 = Normal, 4 = Low 2

GroupWise User Domain The GroupWise domain where the sender’s or 
receiver’s post office is located

Corporate

GroupWise User Post 
Office

The GroupWise post office that the sender or recipient 
belongs to

Temps

GroupWise User ID The user ID of the sender or recipient LTanaka

GroupWise Account ID The recipient’s or sender’s account ID as specified on 
the user’s GroupWise Account page in ConsoleOne

Message Subject The subject line of the message Reminder

Gateway Domain The GroupWise domain where the gateway is installed Connector

Gateway Name The name of the gateway as defined in GroupWise Exchange

Foreign Message ID The message ID supplied by Exchange

Foreign Message Type The type of message sent from Exchange Mail

Foreign Address The user’s Exchange address or GroupWise address 
(if the user was added to a non-GroupWise domain)

Corporate.Market
ing.LTanaka

Number of Recipients The number of users 1

Number of Attachments The number of files attached to the message 0

Accounting Units The byte size of the message 2593
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8.6  Establishing Gateway Administrators
A gateway administrator is any GroupWise user you assign to receive information and error 
messages from the Exchange Gateway. The gateway does not require an administrator, but if you 
want to define one, the administrator must either be a user who is associated with GroupWise or 
with a GroupWise distribution list. There are several types of administrators that you can define for 
the Exchange Gateway:

1 In ConsoleOne, browse to and select the Exchange Gateway object, then click Properties.
2 Click GroupWise > Gateway Administrators to display the Gateway Administrators page.

3 Click Add to display the Select Object dialog box, then select the user you want to define as an 
administrator.
You can also select multiple users and/or distribution lists in the Select GroupWise Object 
dialog box.

Administrator Type Description

Operator The Operator receives a message if the Exchange Gateway cannot 
communicate with the GroupWise system.

Foreign Operator The Foreign Operator receives a message if the Exchange Gateway cannot 
communicate with the Exchange system.

Postmaster The Postmaster receives bad message files if the /badmsg switch is in use. 
See Section 9.5, “Notifying the Exchange Gateway Administrator about Bad 
Messages,” on page 102.

Accountant The gateway keeps accounting records for every message it sends, unless 
you turn the Accounting feature off. Accounting data for the previous day’s 
activity is sent daily to the Accountant. For setup information, see Section 8.5, 
“Setting Up Accounting,” on page 81.
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4 Click OK to return to the Gateway Administrators page and add the user to the Gateway 
Administrators list. 

5 In the Administrator Role box, select the type of administrator you want the user to be.
Operator
Accountant
Postmaster 
Foreign Operator

6 Click OK to save the Exchange Gateway administrator list.
ConsoleOne passes the administrator information to the Exchange Gateway so that the 
administrators start receiving the appropriate types of messages.

8.7  Enabling Message Status for Sent Items
Both GroupWise and Exchange can return status information to message senders. This lets senders 
know if their messages have been delivered, opened, and so on. In order for message status 
information to be returned to senders, you need to make sure that message status has been enabled. 
Message status information is collected in the status correlation database (gwcorr.db), located by 
default in the domain\wpgate\exchange directory. 

1 If you want to change the location of the status correlation database, use the /corr startup switch 
in the Exchange Gateway startup file (gwexch.cfg) to specify a different directory.

2 In ConsoleOne, browse to and right-click the Exchange Gateway object, then click Properties.
3 Click GroupWise > Optional Gateway Settings to display the Optional Gateway Settings page.

4 Fill in the following fields:
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Outbound Status Level:  Outbound status refers to the status information returned to 
GroupWise users for messages they send to Exchange users. Select Undelivered, Delivered, 
Open, or Full (which is equivalent to selecting Undelivered, Delivered, and Open). 
Correlation Enabled:  Select Yes. Message correlation is used to map Exchange delivery, 
non-delivery, and receipt reports to GroupWise status messages, and GroupWise status 
messages to Exchange delivery, non-delivery, and receipt reports. For tracking purposes, each 
message receives its own record in the correlation database 
(domain\wpgate\exchange\gwcorr.db).
Correlation Age:  Specify the number of days you want a message’s record to remain in the 
correlation database. After a message’s record has been deleted, any status information 
returned on the message is sent to the user as a new message rather than as status information 
on the old message.

5 Click OK to save the changes.
ConsoleOne passes the status message information to the Exchange Gateway so that status 
messages and correlation start immediately.

6 If you edited the gwexch.cfg file in Step 1, stop and then start the Exchange Gateway so that it 
reads the updated startup file.

Exchange Gateway Web Console You can adjust these settings for the current gateway session on 
the Optional Gateway Settings page.

8.8  Binding the Exchange Gateway to a Specific 
IP Address
You can now cause the Exchange Gateway to bind to a specified IP address when the server where it 
runs uses multiple IP addresses. The specified IP address is associated with all ports used by the 
gateway. Without an exclusive bind, the gateway binds to all IP addresses available on the server. 

1 In ConsoleOne, browse to and right-click the Exchange Gateway object, then click Properties.
2 Click GroupWise > Network Address to display the Network Address page.
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3 Select Bind Exclusively to TCP/IP Address, then click OK to save your change.

Corresponding Startup Switches You can also use the /ip startup switch in the Exchange Gateway 
startup file to establish an exclusive bind to the specified IP address.
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9Monitoring the Exchange Gateway

By monitoring the Exchange Gateway, you can determine whether or not its current configuration is 
meeting the needs of the users it services. You have a variety of tools to help you monitor the 
operation of the Exchange Gateway:

Section 9.1, “Using the Exchange Gateway Server Console,” on page 89
Section 9.2, “Using the Exchange Gateway Web Console,” on page 92
Section 9.3, “Using Exchange Gateway Log Files,” on page 98
Section 9.4, “Using SNMP Monitoring Programs,” on page 99
Section 9.5, “Notifying the Exchange Gateway Administrator about Bad Messages,” on 
page 102
Section 9.6, “Understanding Exchange Gateway Error Messages,” on page 102

9.1  Using the Exchange Gateway Server Console
The Exchange Gateway server console displays the gateway’s activity when it is running as an 
application. If you run the Exchange Gateway as a Windows service, the server console does not 
appear and you must use other monitoring alternatives, as described in Section 9.2, “Using the 
Exchange Gateway Web Console,” on page 92 and Section 9.4, “Using SNMP Monitoring 
Programs,” on page 99.

To properly administer the gateway as an application, you should understand the console and how it 
works. The screen is divided into various areas.

Section 9.1.1, “Information Box,” on page 90
Section 9.1.2, “Status Box,” on page 90
Section 9.1.3, “Statistics Box,” on page 90
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Section 9.1.4, “Log Message Box,” on page 91
Section 9.1.5, “Menu Summary,” on page 91

9.1.1  Information Box
The top portion of the console provides the following information about the gateway. 

Domain.Gateway:  The domain where the gateway is installed and the name of the gateway.

UpTime:  The length of time the gateway has been running.

Description:  The description you added when you configured the gateway, as described in 
Section 6.2, “Providing Gateway Information,” on page 52.

9.1.2  Status Box
The Status box provides the following information:

Processing:  If the gateway is running, this field displays a spinning bar. If there is no bar or if the 
bar is stationary for an extended period, the gateway is not running.

GroupWise:  Whether the gateway’s network connection to the GroupWise domain is Open or 
Closed. It is normal for this field to briefly display Closed while the gateway is initializing. If the 
link shows Closed for an extended period, a network failure, insufficient access rights, or an error in 
setup fields could be the problem. Check for error messages in the Log Message box. For assistance 
resolving error messages, see Appendix A, “Error and Informational Messages,” on page 117.

Other Link:  The status of the gateway’s network connection to the Exchange system. Messages 
can be sent or received if Other Link is Open. If it is Closed, the network connection has been 
terminated. Check the status of the Exchange system.

Program:  Where the gateway is in its current processing cycle (sending, receiving, or idle). You 
can use the Gateway Time Settings page in ConsoleOne to adjust the processing cycle. For more 
information, see Section 10.1, “Adjusting the Gateway’s Send/Receive Cycle,” on page 103.

Log Level:  The logging level the gateway is currently using. The level determines how much 
information is displayed in the Logging box and written to the log file. You can set the default 
logging level in ConsoleOne, as described in Section 9.3, “Using Exchange Gateway Log Files,” on 
page 98. You can also change the log level for the current Exchange Gateway session, as described 
in “Menu Summary” on page 91.

9.1.3  Statistics Box
The Statistics box displays the amount of incoming and outgoing gateway traffic. The four columns 
display the cumulative totals and the snap shot totals. The four columns from left to right are: 
outgoing message totals, snap shot of outgoing messages (the default snap shot interval is 10 
minutes), incoming message totals, and snap shot of incoming messages.

The snap shot interval statistic can help you get a more accurate picture of the amount of recent 
gateway traffic. For information about changing the snap shot interval, see Section 10.1, “Adjusting 
the Gateway’s Send/Receive Cycle,” on page 103

The following types of status information are provided:
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Normal:  The number of normal incoming and outgoing messages the gateway has processed.

Status:  The number of status messages the gateway has sent and received. The amount of status 
message traffic depends in part on the outbound status level of the gateway. An outbound status 
level set to Full causes more status messages than an outbound status level set to Undelivered. For 
more information about setting the outbound status level, see Section 8.7, “Enabling Message Status 
for Sent Items,” on page 85.

Passthru:  The number of incoming and outgoing passthrough messages the gateway has processed. 
Using the Exchange Gateway as a passthrough gateway between two GroupWise systems is not a 
recommended way to connect GroupWise systems. There are better alternatives currently available. 
See the GroupWise 6.5 Multi-System Administration Guide for preferred alternatives.

Conv Errors:  The number of conversion errors for incoming and outgoing messages.

Comm Errors: The number of communications errors for incoming and outgoing messages.

Total Bytes:  The total number of bytes for the incoming and outgoing messages.

9.1.4  Log Message Box
The Log Message box displays the Exchange Gateway’s activity. The amount and detail in this 
display depends on the logging level you select. For more information, see Section 9.3, “Using 
Exchange Gateway Log Files,” on page 98.

For assistance with error messages that appear in the Log Message box, see Appendix A, “Error and 
Informational Messages,” on page 117.

9.1.5  Menu Summary
At the top of the Exchange Gateway server console is a menu bar that provides the following 
functionality:

Menu Item Function 
Key Function

File Exit F7 Stop the Exchange Gateway.

Configuration Gateway 
Settings

F5 Display the gateway configuration settings from the 
Exchange Gateway object in Novell® eDirectory™. For 
more information, see Chapter 6, “Configuring the 
GroupWise Side of the Exchange Gateway,” on page 51 
and various sections in Chapter 7, “Running the Exchange 
Gateway,” on page 55.

Log View Log Files F9 Select a log file and view it in Notepad. See Section 9.3, 
“Using Exchange Gateway Log Files,” on page 98.

Log Settings F2 Override the default log settings for the current Exchange 
Gateway session. See Section 9.3, “Using Exchange 
Gateway Log Files,” on page 98.
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9.2  Using the Exchange Gateway Web Console
The Exchange Gateway Web console enables you to monitor and control the Exchange Gateway 
from any location where you have access to a Web browser and the Internet. This provides 
substantially more flexible access than the Exchange Gateway server console, which can be 
accessed only from the Windows server where the Exchange Gateway is running.

Section 9.2.1, “Setting Up the Exchange Gateway Web Console,” on page 92
Section 9.2.2, “Accessing the Exchange Gateway Web Console,” on page 94
Section 9.2.3, “Monitoring the Exchange Gateway from the Web Console,” on page 94

9.2.1  Setting Up the Exchange Gateway Web Console
After installation, you set up the Exchange Gateway Web console in ConsoleOne.

1 In ConsoleOne, browse to and right-click the Exchange Gateway object, then click Properties.
2 Click GroupWise > Network Address to display the Network Address page.

3 In the HTTP Port field, provide a unique port number for communication between the 
Exchange Gateway and your Web browser. 

Actions Zero Status F8 Reset all statistics to zero.

Synchronize 
Directories

Turn directory synchronization on or off. See Section 8.1, 
“Enabling Directory Synchronization and Exchange of 
Address Books,” on page 61.

Menu Item Function 
Key Function
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You might want to use a port number close to those used by the MTA and POA, for example, 
7183.

4 Make a note of the HTTP port number. You need this information in order to access the 
Exchange Gateway Web console.

5 Click Apply to save your changes on the Network Address page.
If you want to limit access to the Exchange Gateway Web console, you can provide a username 
and password.

6 Click GroupWise > Optional Gateway Settings.

7 In the HTTP Settings box:
7a In the HTTP User Name field, specify a unique username.
7b Click Set Password.
7c Type the password twice for verification.
7d Click Set Password.

Do not use an eDirectory username and password because the information passes over the 
non-secure connection between your Web browser and the Exchange Gateway.
For convenience, use the same username and password for all GroupWise agents and 
gateways that you plan to monitor from GroupWise Monitor. This saves you from 
providing the username and password information as Monitor accesses each agent and 
gateway.

8 Click OK to save the Exchange Gateway Web console settings.
ConsoleOne then notifies the Exchange Gateway to restart so the new settings can be put into 
effect.
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Corresponding Startup Switches: You could also use the /httpport, /httpuser, and /httppassword 
startup switches in the Exchange Gateway startup file (gwexch.cfg) to enable and secure the 
Exchange Gateway Web console. In addition, you can use the /httprefresh switch to control how 
often the Exchange Gateway refreshes the information provided to your Web browser.

9.2.2  Accessing the Exchange Gateway Web Console
To monitor the Exchange Gateway from your Web browser, view the URL where the Exchange 
Gateway is located by supplying the network address of the Windows server where the Gateway 
runs and the port number as provided on the Network Address page in ConsoleOne.

Syntax: 
http://IP_address_or_hostname:HTTP_port

Examples: 
http://172.16.5.18:7176http://exchserver1:7176

9.2.3  Monitoring the Exchange Gateway from the Web Console
The Exchange Gateway Web console provides several pages of information to help you monitor the 
performance of the Exchange Gateway. The bar at the top of the Exchange Gateway Web console 
displays the name of the Exchange Gateway and its post office. Below this bar appears the Exchange 
Gateway Web console menu that lists the pages of information available in the Exchange Gateway 
Web console. 

Monitoring Gateway Status

When you first access the Gateway Web console, the Status page is displayed.
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The information is the same as is displayed on the Gateway server console on the Windows server 
where the gateway runs. For more information, see “Status Box” on page 90.

Checking Gateway Configuration

On the Exchange Gateway Web console menu, click Configuration to display the configuration 
information stored on various property pages on the Exchange Gateway object in ConsoleOne.

To change the log settings for the current gateway session, click Event Log Settings. All other 
settings listed on the Configuration page must be changed in ConsoleOne.

Checking the Operating System Environment

On the Exchange Gateway Web console menu, click Environment to display information about the 
operating system where the Exchange Gateway is running. 

Viewing Gateway Log Files

On the Exchange Gateway Web console menu, click Log Files to display gateway log files.
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Click Event Log Settings to change the log settings for the current Exchange Gateway session. 

For information about Exchange Gateway log files, see Section 9.3, “Using Exchange Gateway Log 
Files,” on page 98.

Checking and Changing Gateway Time Settings

On the Exchange Gateway Web console menu, click Time Settings to display the settings listed on 
the Time Settings page in ConsoleOne.

Modify the settings as needed, then click Submit to change them for the current Exchange Gateway 
session. For information about the time settings, see Section 10.1, “Adjusting the Gateway’s Send/
Receive Cycle,” on page 103.

Checking and Changing Optional Gateway Settings

On the Exchange Gateway Web console menu, click Optional Gateway Settings to display the 
settings listed on the Optional Gateway Settings page in ConsoleOne.
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Modify the settings as needed, then click Submit to change them for the current Exchange Gateway 
session. For information about the optional gateway settings, see the following topics:

Section 8.1, “Enabling Directory Synchronization and Exchange of Address Books,” on 
page 61
Section 8.5, “Setting Up Accounting,” on page 81
Section 8.7, “Enabling Message Status for Sent Items,” on page 85
Chapter 11, “Using Exchange Gateway Startup Switches,” on page 107

Changing Gateway Access Control

On the Exchange Gateway Web console menu, click Access Control to turn access control on and 
off and to adjust the maximum message size for the current Exchange Gateway session.

For information about access control, see Section 8.4, “Controlling Gateway Access,” on page 73.
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9.3  Using Exchange Gateway Log Files
Log files record all message routing data that appears in the Log Message box of the Exchange 
Gateway server console. You can determine the level of information you want to log, as well as the 
maximum age for log files and the maximum amount of disk space to be used for log files. 
Examining log files is useful if you experience any problems with the Exchange Gateway, because 
the log files record the exact route all messages take. If you have any problems that require 
assistance from Novell Support (http://www.novell.com/support), it is likely that the technician who 
helps you will request a copy of this file. 

Log files are stored in the gateway’s 000.prc directory (domain\wpgate\exchange\000.prc) 
and can be viewed from the Gateway server console and the Web console. Log files are named 
mmddlog.nnn, where mmdd is the month and day and nnn is an incrementing number, starting with 
001.

1 In ConsoleOne, browse to and right-click the Exchange Gateway object, then click Properties.
2 Click GroupWise > Log Settings to display the Log Settings page.

3 Fill in the following fields:
Log File Path:  Select the path where the log file should be created. By default, log files are 
stored in the domain\wpgate\exchange\000.prc directory.
Logging Level:  Select the logging level you want. Gateway logging levels are hierarchical, 
with Off as the lowest and Diagnostic as the highest.

Off:  Disables logging.
Normal:  Displays basic message routing information, providing a summary of gateway 
activity. This is the default setting.
Verbose:  Displays extra message routing details and message processing information.
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Diagnostic:  Displays all message routing and processing information. You should use 
this logging level only when troubleshooting a problem with the gateway.

A new log file is created each day, and the files accumulate according to the following settings:
Max Log File Age:  Specify the maximum number of days you want to save the log file before 
the gateway deletes it. The default value is 7 days.
Max Log Disk Space:  Specify the amount of disk space you want the limit to be for log files. 
When the limit is reached, the gateway deletes the oldest file until the space occupied is under 
the maximum allowable limit. The default value is 1024 KB.
If you set the limit to zero (0), there is no disk space limit for log files.

4 Click OK to save the log settings.
ConsoleOne passes the updated log settings to the Exchange Gateway so that the new log 
settings are in force immediately.

Corresponding Startup Switches You could also use the /log, /loglevel, /logdays, and /logmax 
startup switches in the Exchange Gateway startup file (gwexch.cfg) to control logging.

Exchange Gateway Web Console You can view the Exchange Gateway log files and change the 
log settings for the current Exchange Gateway session by clicking the Log Settings link on the Log 
Files page. You can also view and modify log settings at the Exchange Gateway server console on 
the server where the gateway is running, as listed in “Menu Summary” on page 91.

9.4  Using SNMP Monitoring Programs
You can monitor the Exchange Gateway from Novell ZENworks for Servers or any other SNMP 
management and monitoring program. When properly configured, the Exchange Gateway sends 
SNMP traps to network management consoles for display along with other SNMP monitored 
programs.

During installation, you had the opportunity to configure the Exchange Gateway for SNMP. If the 
option was dimmed, then SNMP was not installed on the Windows server.
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If you did not select SNMP support during installation, there is currently no way to add the 
functionality short of uninstalling the Exchange Gateway and reinstalling it. See Section 7.4, 
“Uninstalling the Exchange Gateway,” on page 58

To set up SNMP services for the Windows server, complete the following tasks:

Section 9.4.1, “Copying and Compiling the Exchange Gateway MIB File,” on page 100
Section 9.4.2, “Configuring the Exchange Gateway for SNMP Monitoring,” on page 100

9.4.1  Copying and Compiling the Exchange Gateway MIB File
An SNMP-enabled Exchange Gateway returns information contained in a Management Information 
Base (MIB). The MIB is an ASCII data structure that defines the information gathered. It also 
defines the properties that can be monitored and managed on the SNMP-enabled Exchange 
Gateway. You can view the contents of the Exchange Gateway MIB for a description of the SNMP 
variables available for it. The Exchange Gateway MIB is located in the domain\wpgate\exchange 
directory.

Before you can monitor an SNMP-enabled Exchange Gateway, you must compile the ngwln.mib 
file using your SNMP management program. 

1 Copy the ngwln.mib file from the domain\wpgate\exchange directory to the location 
required by your SNMP management program.
ZENworks users can copy the ngwln.mib file to the \agents\snmp directory in the 
GroupWise software distribution directory.

2 Compile or import the ngwln.mib file as required by your SNMP management program.
For example, to compile the ngwln.mib file for ZENworks:
2a In ConsoleOne, right-click the Site Server object, then click Properties > MIB Pool.
2b Click Modify Pool > Add.
2c Browse to and select the ngwln.mib file, then click OK.
2d Click Compile.
2e To make sure that the Windows server where the Exchange Gateway is running is 

configured to send SNMP traps to the ZENworks Site Server, add the IP address or 
hostname of the Site Server to the list of trap destinations.

From the Windows NT Control Panel, double-click Network, then click Services > 
SNMP Service > Properties > Traps.
From the Windows 2000/2003 Control Panel, double-click Administrative Tools, 
then click Services > SNMP Service > Properties > Traps.

Refer to your SNMP management program documentation for specific instructions.
3 Continue with “Configuring the Exchange Gateway for SNMP Monitoring” on page 100.

9.4.2  Configuring the Exchange Gateway for SNMP Monitoring
In order for SNMP monitoring programs to monitor the Exchange Gateway, the Exchange Gateway 
must be configured with a network address and SNMP community string.

1 Browse to and right-click the Exchange Gateway object, then click Properties.
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2 Click GroupWise > Network Address to display the Network Address page.

3 Click the pencil icon to provide the TCP/IP address or hostname of the server where the 
Exchange Gateway runs, then click Apply.
The Exchange Gateway does not currently support SSL.

4 Click GroupWise > Identification.
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5 Provide your system SNMP community GET string, then click OK.
ConsoleOne then notifies the Exchange Gateway to restart so the new settings can be put into 
effect.

The Exchange Gateway should now be visible to your SNMP monitoring program.

9.5  Notifying the Exchange Gateway 
Administrator about Bad Messages
Occasionally, the Exchange Gateway encounters a message that it cannot process, either because the 
message file has been damaged or because the recipient is not a user that is recognized by the 
gateway. You can use the /badmsg switch in the Exchange Gateway startup file to indicate how you 
want the Exchange Gateway to handle messages that are damaged or undeliverable. 

By default, bad messages are moved to the domain\wpgate\exchange\gwprob directory (the 
equivalent of /badmsg-move). If you want to take a look at bad message files, you can have the 
gateway send the bad message files to the postmaster using /badmsg-send. If you do not yet have a 
postmaster, see Section 8.6, “Establishing Gateway Administrators,” on page 84 for setup 
instructions.

If you do not want to do anything with bad messages, you can have the gateway delete them 
immediately using /badmsg-neither.

9.6  Understanding Exchange Gateway Error 
Messages
As you monitor the Exchange Gateway, you might occasionally see error messages. Exchange 
Gateway error messages are documented with the source of the error, possible causes of the error, 
and actions to take to resolve the error. See Appendix A, “Error and Informational Messages,” on 
page 117.
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10Optimizing the Exchange Gateway

You can adjust how the Exchange Gateway functions in order to optimize its performance. Before 
attempting optimization, you should run the Exchange Gateway long enough to observe its 
efficiency and its impact on other network applications running on the same server. See Chapter 9, 
“Monitoring the Exchange Gateway,” on page 89.

Also, remember that optimizing your network hardware and operating system can make a difference 
in Exchange Gateway performance.

The following topics help you optimize the Exchange Gateway:

Section 10.1, “Adjusting the Gateway’s Send/Receive Cycle,” on page 103
Section 10.2, “Adjusting the Number of Sender and Receiver Threads,” on page 105
Section 10.3, “Automating Network Reattachment,” on page 105
Section 10.4, “Reducing Network Traffic,” on page 106

10.1  Adjusting the Gateway’s Send/Receive 
Cycle
The Exchange Gateway’s send/receive cycle determines how much time the gateway spends 
sending messages as opposed to receiving them. The send process refers to messages sent from 
GroupWise to Exchange; the receive process refers to messages sent from Exchange to GroupWise.

The default send/receive cycle is 120 seconds, which causes the gateway to send messages for a 
maximum of 60 seconds and then receive messages for 60 seconds. You can adjust the send/receive 
cycle to better suit your environment and needs. You can also adjust some additional time-related 
settings for the gateway.

1 In ConsoleOne, browse to and right-click the Exchange Gateway object, then click Properties.
2 Click GroupWise > Gateway Time Settings to display the Gateway Time Settings page.
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3 Fill in the following fields:
Send/Receive Cycle:  Specify the maximum amount of time you want the gateway to spend 
sending and receiving messages during one cycle. The default cycle is 120 seconds, which 
causes the gateway to send messages for a maximum of 60 seconds and to receive messages for 
60 seconds. The cycle is then repeated.
If the time limit is reached and a message is being processed, the gateway finishes processing 
the message.
Minimum Run:  This field does not apply to the Exchange Gateway.
Idle Sleep Duration:  Specify the number of seconds the gateway is to remain idle if it has no 
commands or messages to process. The default value is 30 seconds.
The gateway constantly polls its directory for messages to process. The purpose of idle time is 
to save CPU cycles and to keep network traffic manageable.
Snap Shot Interval:  The Exchange Gateway server console shows the gateway statistics for 
the last x minutes (an interval you specify). The default interval is 10 seconds. Gateway activity 
is updated every minute.

4 Click OK to save the updated time settings.
ConsoleOne then notifies the Exchange Gateway to restart so the new settings can be put into 
effect.

Exchange Gateway Web Console You can adjust these settings for the current gateway session on 
the Time Settings page.
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10.2  Adjusting the Number of Sender and 
Receiver Threads
The Exchange Gateway can be configured to start from varying numbers of sender and receiver 
threads, depending on the amount of traffic passing through the gateway. The heavier the traffic, the 
more threads you should configure the gateway to start. By default, 4 sender threads and 4 receiver 
threads are started.

Use the /st switch in the Exchange Gateway startup file (gwexch.cfg) to set the number of sender 
threads. Use the /rt switch to set the number of receiver threads.

Exchange Gateway Web Console You can check the number of sender and receiver threads that 
are currently available and in use on the Status page.

10.3  Automating Network Reattachment
When the Exchange Gateway loses its link to the server where the GroupWise domain directory 
resides or its link to the Exchange server, it can attempt to reestablish the link.

1 In ConsoleOne, browse to and right-click the Exchange Gateway object, then click Properties.
2 Click GroupWise > Optional Gateway Settings to display the Optional Gateway Settings page.

3 Make sure that Enable Recovery is set to Yes.
4 Fill in the following fields:

Retry Count:  Specify the number of times you want the gateway to attempt to recover the 
network link. The default is 10 times.
Retry Interval:  Specify the amount of time you want the gateway to wait between retry 
attempts. The default value is 60 seconds.
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Failed Recovery Wait:  If the gateway cannot reconnect to the network after the number of 
times specified in Retry Count, it stops attempting to reconnect. Specify the amount of time 
you want the gateway to wait until it starts the reconnect process again. The default value is 
3600 seconds (1 hour).
Network Reattach Command:  You can create a batch file that the gateway can use to 
reconnect to the network server where the GroupWise domain directory resides and to the 
Exchange/Domino server. Specify the name of the batch file in this field.

5 Click OK to save the reattachment information.
ConsoleOne then notifies the Exchange Gateway to restart so the new settings can be put into 
effect.

10.4  Reducing Network Traffic
By default, the Exchange Gateway’s queue directories are located in the 
domain\wpgate\exchange directory on the server where the domain is located. If the gateway is 
not installed on the same server with the domain directory structure, you can reduce network traffic 
by redirecting the gateway’s queue directories to the Windows server where the gateway is running.

If you choose to place the queue directories on the gateway server’s local drive, make sure the 
gateway server has sufficient disk space, memory, and processing power to handle the load.

Start the gateway using the following startup switch:

exgate.exe /work-queue_directory 

where queue_directory is the path to the directory where you want the gateway queues created. For 
example, you could use a c:\exchgate directory on the local drive. Make sure the directory is not 
used by any other program. The gateway must have exclusive access to the directory; any 
unrecognized files in the directory are immediately moved to the gwprob subdirectory.

The first time you start the gateway using the /work switch, the gateway creates the necessary file 
structure in the specified directory. It creates a wpgate directory, with wpcsin and wpcsout queue 
directories. This local structure is used as long as you continue to start the gateway with the /work 
switch. You might want to add the /work switch to the startup file (gwexch.cfg) so the gateway 
always uses the same queue directory. See Chapter 11, “Using Exchange Gateway Startup 
Switches,” on page 107. 
Wise 7 Gateway for Microsoft Exchange Installation and Administration Guide



11
novdocx (en)  16 A

pril 2010
11Using Exchange Gateway Startup 
Switches

Startup switches let you set various operational parameters for the gateway. Some startup switches 
override configuration information, such as logging level, that you can set in ConsoleOne. Other 
switches provide configuration options not available anywhere else.

To use a startup switch, you can include it on the command line immediately following the 
exgate.exe executable command.

Example: 

exgate.exe /badmsg-send

You can also edit the Exchange Gateway startup file (gwexch.cfg) to include the switches you 
want to use when starting the gateway. The gwexch.cfg file is located in the 
domain\wpgate\exchange directory. Use the following syntax to include the startup file:

Example: 

exgate.exe @gwexch.cfg

The table below summarizes Exchange Gateway startup switches and how they correspond to 
configuration settings in ConsoleOne.

Startup Switch ConsoleOne Setting

/addressrule N/A

/allowdom N/A

/badmsg N/A 

/blockdom N/A

/corr N/A

/custom N/A

/displaynamelastfirst N/A

/group N/A

/help N/A

/home N/A

/httppassword HTTP Password

/httpport HTTP Port

/httprefresh N/A

/httpuser HTTP Username

/importsubcontainers N/A
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See Exchange Gateway Best Practices (http://www.novell.com/documentation/gwgateways/pdfdoc/
best_practices/Exchange_Gateway_Best_Practices_by_Consultant_Ed_Hanley.pdf) by consultant 
Ed Hanley for information about some useful undocumented switches.

11.1  /addressrule
Establishes the format of user addresses when sending a busy search request to the Exchange 
system.

Syntax: 

/addressrule-address_format

The address_format variable can be replaced with any combination of the following tags:

<domain>
<username>
<firstname>
<lastname>
<firstinitial>
<lastinitial>

See Section 8.2.5, “Setting Up an Addressing Rule to Facilitate Busy Searches,” on page 71 for 
examples.

/ip TCP/IP Address

/log Log File Path

/logdays Maximum Log File Age

/loglevel Log Level

/logmax Maximum Log File Size

/nohtml N/A

/noreadreceipt N/A

/recv N/A

/rt N/A

/send N/A

/single N/A

/st N/A

/useimportcontainer N/A

/work N/A

Startup Switch ConsoleOne Setting
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11.2  /allowdom
Affects outbound directory exchange and allows only users in the specified GroupWise domains to 
appear in the Microsoft Exchange address book when directory synchronization and exchange are 
enabled. Users from all unlisted domains are blocked. See Section 8.1, “Enabling Directory 
Synchronization and Exchange of Address Books,” on page 61

Syntax: 

/allowdom-domain
/allowdom-"list_of_domains"

Examples: 

/allowdom-domain1
/allowdom-"domain1, domain2, domain3"

See also /blockdom.

IMPORTANT: Do not use the /allowdom and /blockdom switches together. If both are specified, 
only the /allowdom switch takes effect.

11.3  /badmsg
Indicates what the gateway should do with bad message files (undeliverable or damaged). See 
Section 9.5, “Notifying the Exchange Gateway Administrator about Bad Messages,” on page 102. 
The following options can be used:

Move: Instructs the gateway to move the bad message files to the 
domain\wpgate\exchange\gwprob directory. This is the default action.
Send:  Instructs the gateway to send the bad message files to the user assigned as the gateway’s 
Postmaster. See Section 8.6, “Establishing Gateway Administrators,” on page 84. 
Both:  Instructs the gateway to both move and send the bad message files.
Neither:  Instructs the gateway to delete the files.

Syntax: 

/badmsg-option

Example: 

/badmsg-both

11.4  /blockdom
Affects outbound directory exchange and prevents users in the specified GroupWise domains from 
appearing in the Exchange Address Book when directory synchronization and exchange are enabled. 
Users from all unlisted domains are allowed. See Section 8.1, “Enabling Directory Synchronization 
and Exchange of Address Books,” on page 61.
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Syntax: 

/blockdom-domain
/blockdom-"list_of_domains"

Examples: 

/blockdom-domain1
/blockdom-"domain1, domain2, domain3"

See also /allowdom.

IMPORTANT: Do not use the /allowdom and /blockdom switches together. If both are specified, 
only the /allowdom switch takes effect.

11.5  /corr
Specifies the path where the correlation database (gwcorr.db) used for message status tracking is to 
be redirected. By default, the correlation database is located in the domain\wpgate\exchange 
directory. For information about the correlation database, see Section 8.7, “Enabling Message Status 
for Sent Items,” on page 85.

Syntax: 

/corr-[drive:]\directory
/corr-\\server\sharename\directory

Example: 

/corr-\exchgate\statcorr
/corr-m:\exchgate\statcorr
/corr-\\server2\c$\exchgate\statcorr

11.6  /custom
Enables synchronization of custom recipients from Exchange to GroupWise. By default, custom 
recipients are not synchronized. See Section 8.1, “Enabling Directory Synchronization and 
Exchange of Address Books,” on page 61 and “Including Custom Users in Directory 
Synchronization” on page 71.

Syntax: 

/custom

11.7  /displaynamelastfirst
Formats the names of GroupWise users as LastName, FirstName in the Exchange Address Book. 
The default is FirstName LastName

Syntax: 
/displaynamelastfirst
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11.8  /group
Turns on group expansion. If enabled, incoming messages addressed to a public group (distribution 
list) are sent to members of that group. Group expansion is on by default.

Syntax: 

/group

11.9  /help
Displays information about the Exchange Gateway switches.

Syntax: 

/help

11.10  /home
Specifies the path to the gateway root directory (domain\wpgate\exchange). 

IMPORTANT: You cannot move the Exchange Gateway software to a different location.

Syntax: 

/home-[drive:]\directory
/home-\\server\sharename\directory

Example: 

/home-\exchgate\work
/work-m:\exchgate\work
/work-\\server2\c$exchngate\work

11.11  /httppassword
Specifies the password for the Exchange Gateway to prompt for before allowing gateway status 
information to be displayed in your Web browser. Do not use an existing Novell eDirectory 
password because the information passes over the non-secure connection between your Web 
browser and the Exchange Gateway. See Section 9.2, “Using the Exchange Gateway Web Console,” 
on page 92.

Syntax: 

/httppassword-password

Example: 

/httppassword-GWiseExchange

See also /httpuser, /httpport, and /httprefresh.
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11.12  /httpport
Sets the HTTP port number used for the Exchange Gateway to communicate with your Web 
browser. The setting must be unique on the server where the Exchange Gateway runs. See 
Section 9.2, “Using the Exchange Gateway Web Console,” on page 92.

Syntax: 

/httpport-port_number

Example: 

httpport-7175

See also /httpuser, /httppassword, and /httprefresh.

11.13  /httprefresh
Specifies the rate at which the Exchange Gateway refreshes the status information in your Web 
browser. The default is 60 seconds. See Section 9.2, “Using the Exchange Gateway Web Console,” 
on page 92.

Syntax: 

/httprefresh-seconds

Example: 

/httprefresh-30

See also /httpuser, /httppassword, and /httpport.

11.14  /httpuser
Specifies the username for the Exchange Gateway to prompt for before allowing gateway status 
information to be displayed in a Web browser. Providing a username is optional. Do not use an 
existing eDirectory username because the information passes over the non-secure connection 
between your Web browser and the Exchange Gateway. See Section 9.2, “Using the Exchange 
Gateway Web Console,” on page 92.

Syntax: 
/httpuser-username

Example: 

/httpuser-GateWatcher

See also /httppassword, /httpport, and /httprefresh.

11.15  /importsubcontainers
Causes the gateway to include all nested subcontainers when importing Exchange users from 
Exchange export containers as part of the connector configuration process See Chapter 5, 
“Configuring the Exchange Side of the Exchange Gateway,” on page 31.
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Syntax: 

/importsubcontainers

11.16  /ip
Binds the Exchange Gateway to a specific IP address when the server where it runs uses multiple IP 
addresses, such as in a clustering environment. The specified IP address is associated with all ports 
used by the gateway (message transfer and HTTP). Without the /ip switch, the gateway binds to all 
available IP addresses. See Section 8.8, “Binding the Exchange Gateway to a Specific IP Address,” 
on page 86.

Syntax: 

/ip-network_address

Example: 

/ip-172.16.5.18
/ip-exchsvr.provo.novell.com

11.17  /log
Redirects the log files to the specified directory. By default, the log files are created in the 
domain\wpgate\exchange\000.prc directory. See Section 9.3, “Using Exchange Gateway Log Files,” 
on page 98.

Syntax: 

/log-[drive:]\directory
/log-\\server\sharename\directory

Example: 

/log-\exchgate\logs
/log-m:\exchgate\logs
/log-\\server2\c$\exchgate\logs

See also /loglevel, /logdays, and /logmax.

11.18  /logdays
Overrides the maximum log file age specified in ConsoleOne. Any log files older than the number 
of days you specify are deleted. The range is from 1 to 360 days. See Section 9.3, “Using Exchange 
Gateway Log Files,” on page 98.

Syntax: 
logdays-days

Example: 
/logdays-30

See also /log, /loglevel, and /logmax.
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11.19  /loglevel
Overrides the log level specified in ConsoleOne. Possible options are Off, Normal, Verbose, and 
Diagnostic. See Section 9.3, “Using Exchange Gateway Log Files,” on page 98.

Syntax: 

/loglevel-level

Example: 
/loglevel-verbose

See also /log, /logdays, and /logmax.

11.20  /logmax
Overrides the maximum log file disk space specified in ConsoleOne. If the maximum disk space 
limit is reached, the oldest log file is deleted to make room for a new one. Specify the number of 
kilobytes you want to use. The default is 1024 KB or 1 MB. The range is from 256 KB to unlimited 
size. Use 0 for unlimited disk space. See Section 9.3, “Using Exchange Gateway Log Files,” on 
page 98.

Syntax: 

/logmax-kilobytes

Example: 
/logmax-2048

See also /log, /loglevel, and /logdays.

11.21  /nohtml
Causes the Exchange Gateway to use RTF format for message bodies, rather than HTML format.

Syntax: 

/nohtml

11.22  /noreadreceipt
Suppresses the prompt for sending Outlook read receipts for GroupWise messages, while allowing 
the read receipt feature in Outlook to work normally for non-GroupWise messages.

Syntax: 
/noreadreceipt

11.23  /recv
Puts the gateway in receive-only mode, so that it receives messages from the Exchange system but 
does not send messages to the Exchange system.
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Syntax: 

/recv

See also /send.

11.24  /rt
Specifies the number of receiver threads that the Exchange Gateway should start. The default it 4. 
There is no limit to the number of threads you can start, but nothing is gained by starting threads that 
are always idle. See Section 10.2, “Adjusting the Number of Sender and Receiver Threads,” on 
page 105.

Syntax: 

/rt-threads

Example: 

/rt-3

See also /st.

11.25  /send
Puts the gateway in send-only mode, so that it sends messages to the Exchange system but does not 
receive messages from the Exchange system.

Syntax: 

/send

See also /recv.

11.26  /single
Instructs the gateway to run for one send/receive cycle, then shut down. For information about the 
send/receive cycle, see Section 10.1, “Adjusting the Gateway’s Send/Receive Cycle,” on page 103.

Syntax: 
/single

11.27  /st
Specifies the number of sender threads that the Exchange Gateway should start. The default it 4. 
Valid values range from 1 to 4. See Section 10.2, “Adjusting the Number of Sender and Receiver 
Threads,” on page 105.

Syntax: 

/st-threads

Example: 

/st-3
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See also /rt.

11.28  /useimportcontainer
Causes the Exchange Gateway to synchronize GroupWise users into the import container specified 
in the object properties of the Exchange Gateway’s connector object. By default, GroupWise users 
are synchronized to a container named GroupWise at the root of Active Directory when this switch 
is not used.

For more information, see Section 5.1, “Configuring Exchange 5.5,” on page 31 or Section 5.2.1, 
“Performing Basic Configuration for Exchange 2000/2003,” on page 34.

Syntax: 
/useimportcontainer

11.29  /work
Indicates the path where temporary files are stored while messages are transferred. You can use a 
path to a location on the Windows server where the gateway is running or on the server where the 
domain directory is located. For more information, see Section 10.4, “Reducing Network Traffic,” 
on page 106.

Syntax: 

/work-[drive:]\directory
/work-\\server\sharename\directory

Example: 

/work-\exchgate\work
/work-m:\exchgate\work
/work-\\server2\c$\exchgate\work
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AError and Informational Messages 

This section helps you resolve error messages that appear in Exchange Gateway log files and other 
places where gateway status information is displayed:

“Error Messages” on page 117
“Informational Messages” on page 132

Additional sources of troubleshooting assistance include:

Novell Support Knowledgebase (http://www.novell.com/support/supportcentral)
GroupWise Product Support Forums (http://support.novell.com/forums/2gw.html)
GroupWise Support Community (http://support.novell.com/products/groupwise)
GroupWise Cool Solutions (http://www.novell.com/coolsolutions/gwmag/index.html)

A.1  Error Messages
“Access to a recipient in the message has been denied while processing inbound message” on 
page 119
“Configuration database not found” on page 119
“Conversion cleanup error while processing inbound message” on page 119
“Conversion error while processing inbound message” on page 119
“Conversion initialization error while processing inbound message” on page 119
“Conversion initialization error while processing outbound message” on page 120
“Could not connect to server share” on page 120
“Could not remove the file named gwproxydll.bak” on page 120
“Error accessing Microsoft Exchange message property while processing inbound message” on 
page 120
“Error converting addresses between Microsoft Exchange and GroupWise formats while 
processing inbound or outbound message” on page 121
“Exchange server was down while initializing the gateway” on page 121
“Export from Exchange reported problems while performing an inbound directory operation” 
on page 121
“Foreign domain information not available while performing an inbound directory operation” 
on page 121
“Foreign host information not available while performing an inbound directory operation” on 
page 121
“Foreign user information not available while performing an inbound directory operation” on 
page 122
“Gateway Object Identifier in the registry was invalid while initializing the gateway” on 
page 122
“Ignoring recipient FirstName/LastName (Bad GroupWise proxy)” on page 122
Error and Informational Messages 117
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“Ignoring recipient (No FirstName/LastName) (Bad GroupWise proxy)” on page 122
“MAPI initialization failed while initializing the gateway” on page 123
“Memory allocation failed while performing an inbound directory operation” on page 123
“Memory allocation failed while performing an outbound directory operation” on page 123
“Message server directories do not exist” on page 123
“No active recipients while processing inbound message” on page 124
“No active recipients while processing outbound message” on page 124
“Unable to access the Microsoft Exchange gateway mailbox” on page 124
“Unable to add data to correlation record while processing inbound message” on page 124
“Unable to commit correlation record while processing inbound message” on page 125
“Unable to construct message while processing inbound message” on page 125
“Unable to convert a directory field while performing an inbound directory operation” on 
page 125
“Unable to convert attachment while processing inbound message” on page 126
“Unable to convert attachment while processing outbound message” on page 126
“Unable to convert message body while processing inbound message” on page 126
“Unable to create directory” on page 126
“Unable to create correlation record while processing inbound message” on page 127
“Unable to create gateway profile while initializing the gateway” on page 127
“Unable to create message while processing inbound message” on page 127
“Unable to find gateway root directory while performing an outbound directory operation” on 
page 127
“Unable to find inbound DLL while initializing the gateway” on page 127
“Unable to find outbound DLL while initializing the gateway” on page 128
“Unable to find primary domain name while performing an inbound directory operation” on 
page 128
“Unable to generate accounting record while processing outbound message” on page 128
“Unable to generate status message while processing inbound message” on page 129
“Unable to get configuration information from registry while initializing the gateway” on 
page 129
“Unable to get configuration information from Site Addressing object while initializing the 
gateway” on page 129
“Unable to get configuration information from the MAPI Session while initializing the 
gateway” on page 129
“Unable to get MAPI Session while initializing the gateway” on page 130
“Unable to locate gateway home directory” on page 130
“Unable to map recipients while processing outbound message” on page 130
“Unable to obtain directory handle while initializing directory operations” on page 131
“Unable to obtain directory handle while performing an outbound directory operation” on 
page 131
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“Unable to open the configuration file from the MAPI session” on page 131
“Unable to open the event log while initializing the gateway” on page 131
“Unable to send Non-Delivery Report while processing inbound message” on page 131
“Unable to set Microsoft Exchange message property while processing outbound message” on 
page 131
“Undeliverable message while processing inbound message” on page 132
“Unknown message type while processing inbound message” on page 132

Access to a recipient in the message has been denied while processing inbound 
message

Source: GroupWise Exchange Gateway.

Explanation: The sender or the recipient has no access to the gateway.

Action: Verify that the sender or recipient has access to the gateway.

Configuration database not found 

Source: GroupWise Exchange Gateway.

Explanation: The gateway home directory is not defined during the gateway startup.

Action: Run the gateway from the gateway home directory or specify the /home startup 
switch correctly in the gwexch.cfg file.

Conversion cleanup error while processing inbound message

Source: GroupWise Exchange Gateway.

Explanation: The gateway is unable to delete the message from the mts-out folder of the 
gateway mailbox after converting it to a GroupWise message.

Action: Verify that the Microsoft Exchange server is running.

Conversion error while processing inbound message

Source: GroupWise Exchange Gateway.

Explanation: The gateway is unable to spawn a thread to convert a message from Exchange 
to GroupWise format. 

Possible Cause: Insufficient memory to perform the operation.

Possible Cause: The gateway server might have too many applications running.

Action: Stop some applications or move them to a different server.

Possible Cause: The gateway server might not meet the system memory requirements listed in 
Chapter 2, “Exchange Gateway System Requirements,” on page 13.

Action: Install additional memory.

Conversion initialization error while processing inbound message

Source: GroupWise Exchange Gateway.
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Explanation: The gateway is unable to find the configuration parameters for gwin.dll 
under the registry key 
HKEY_LOCAL_MACHINE\SOFTWARE\Classes\MAPI Conversions.

Action: Verify that this registry entry exists. If not, reinstall the gateway after 
uninstalling the previous instance of the gateway. See Section 7.4, 
“Uninstalling the Exchange Gateway,” on page 58.

Conversion initialization error while processing outbound message

Source: GroupWise Exchange Gateway.

Explanation: The gateway is unable to find the configuration parameters for gwout.dll 
under the registry key 
HKEY_LOCAL_MACHINE\SOFTWARE\Classes\MAPI Conversions.

Action: Verify that this registry entry exists. If not, reinstall the gateway after 
uninstalling the previous instance of the gateway. See Section 7.4, 
“Uninstalling the Exchange Gateway,” on page 58.

Could not connect to server share

Source: GroupWise Exchange Gateway.

Explanation: Permissions do not exist on the server for remote login during installation.

Action: Set appropriate permissions on the Windows server to enable remote login.

Explanation: Network problems are preventing access to the server share during installation.

Action: Check the network status.

Could not remove the file named gwproxydll.bak

Source: GroupWise Exchange Gateway.

Explanation: If you are installing a new version of the gateway while an older version of the 
gateway exists on the server, the Installation program tries to replace the 
gwproxy.dll, but the process cannot be completed because the existing 
version of gwproxy.dll is loaded into memory.

Action: Remove gwproxy.dll from memory. You can do this by stopping the System 
Attendant service and restarting it immediately. You can then click Retry. Do 
not click Retry before the services and their dependencies have started. 

Error accessing Microsoft Exchange message property while processing inbound 
message

Source: GroupWise Exchange Gateway.

Explanation: The message might be damaged.

Action: Send the message again.

Explanation: The Exchange server might not be running. 

Action: Verify that the Microsoft Exchange server is running. See Chapter 5, 
“Configuring the Exchange Side of the Exchange Gateway,” on page 31.
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Error converting addresses between Microsoft Exchange and GroupWise formats 
while processing inbound or outbound message

Source: GroupWise Exchange Gateway.

Explanation: The gateway is unable to locate the Exchange address table to map addresses 
between Exchange and GroupWise formats.

Action: Verify that the GWISE address type is installed. See Chapter 5, “Configuring 
the Exchange Side of the Exchange Gateway,” on page 31.

Action: Verify that the Exchange server is running. See Chapter 5, “Configuring the 
Exchange Side of the Exchange Gateway,” on page 31.

Exchange server was down while initializing the gateway

Source: GroupWise Exchange Gateway.

Explanation: The Exchange server services are not running.

Action: Run the Exchange server services as described in Chapter 5, “Configuring the 
Exchange Side of the Exchange Gateway,” on page 31, then restart the 
gateway. See Section 7.1, “Starting the Exchange Gateway,” on page 55.

Export from Exchange reported problems while performing an inbound directory 
operation

Source: GroupWise Exchange Gateway.

Explanation: The export of user objects from Exchange has encountered a problem. The 
gateway is unable to obtain objects to exchange with the GroupWise system.

Action: Any corruption in the Exchange system needs to be identified and corrected.

Foreign domain information not available while performing an inbound directory 
operation

Source: GroupWise Exchange Gateway.

Explanation: The domain information is not available for the object being processed.

Possible Cause: The object does not have a GroupWise-type address or the address is invalid.

Action: Install the addressing components on the server. See Section 4.4, “Installing 
the Exchange Gateway Addressing Components,” on page 27.

Foreign host information not available while performing an inbound directory 
operation

Source: GroupWise Exchange Gateway.

Explanation: The host information is not available for the object being processed.

Possible Cause: The object does not have a GroupWise-type address or the address is invalid.

Action: Install the addressing components on the server. See Section 4.4, “Installing 
the Exchange Gateway Addressing Components,” on page 27.
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Foreign user information not available while performing an inbound directory 
operation

Source: GroupWise Exchange Gateway.

Explanation: The user information is not available for the object being processed.

Possible Cause: The object does not have a GroupWise-type address or the address is invalid.

Action: Install the addressing components on the server. See Section 4.4, “Installing 
the Exchange Gateway Addressing Components,” on page 27.

Action: Ensure that the address format for GWISE contains %m as a component. See 
Section 3.8, “Selecting User Address Type and Format,” on page 19 and 
Chapter 5, “Configuring the Exchange Side of the Exchange Gateway,” on 
page 31.

Gateway Object Identifier in the registry was invalid while initializing the gateway

Source: GroupWise Exchange Gateway.

Explanation: The Gateway Object Identifier in the registry no longer matches a gateway 
object in the Exchange Directory.

Action: Uninstall the old gateway and reinstall the gateway. See Section 7.4, 
“Uninstalling the Exchange Gateway,” on page 58 and Chapter 4, “Installing 
the Exchange Gateway,” on page 25.

Ignoring recipient FirstName/LastName (Bad GroupWise proxy)

Source: GroupWise Exchange Gateway.

Explanation: Every Exchange recipient object has a GroupWise-type address generated for 
it when the gateway starts for the first time. If for some reason, this address 
could not be created, the user cannot be exchanged/synchronized with 
GroupWise because vital information is missing.

Action: View the application event log (Start > Programs > Administrative Tools > 
Event Viewer) for reasons as to why the address was not created. Reasons 
could include invalid characters, absence of vital components such as the 
mailbox name, and so forth.

Explanation: A GroupWise-type address for the recipient object exists but the address has a 
domain name that is the same as that of the GroupWise primary domain name.

Action: If this is a problem with most of the objects, then you might need to change the 
address format for GWISE. See “Determining Connections between Systems” 
on page 19, Section 3.8, “Selecting User Address Type and Format,” on 
page 19, and Chapter 5, “Configuring the Exchange Side of the Exchange 
Gateway,” on page 31.

Ignoring recipient (No FirstName/LastName) (Bad GroupWise proxy)

Source: GroupWise Exchange Gateway.

Explanation: Every Exchange recipient object has a GroupWise-type address generated for 
it when the gateway starts for the first time. If for some reason, this address 
could not be created, the user cannot be exchanged or synchronized with 
GroupWise because vital information is missing.
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Action: View the application event log (Start > Programs > Administrative Tools > 
Event Viewer) for reasons as to why the address was not created. Reasons 
could include invalid characters, absence of vital components such as the 
mailbox name, and so forth.

Explanation: A GroupWise-type address for the recipient object exists but the address has a 
domain name that is the same as that of the GroupWise primary domain name.

Action: If this is a problem with most of the objects, then you might need to change the 
address format for GWISE. See “Determining Connections between Systems” 
on page 19, Section 3.8, “Selecting User Address Type and Format,” on 
page 19, and Chapter 5, “Configuring the Exchange Side of the Exchange 
Gateway,” on page 31.

MAPI initialization failed while initializing the gateway

Source: GroupWise Exchange Gateway.

Explanation: The MAPI subsystem does not exist or is corrupted.

Action: Reinstall the MAPI subsystem.

Memory allocation failed while performing an inbound directory operation

Source: GroupWise Exchange Gateway.

Explanation: Insufficient memory to perform the current operation.

Possible Cause: The gateway server might have too many applications running.

Action: Stop some applications or move them to a different server.

Possible Cause: The gateway server might not meet the system memory requirements listed in 
Chapter 2, “Exchange Gateway System Requirements,” on page 13.

Action: Install additional memory.

Memory allocation failed while performing an outbound directory operation

Source: GroupWise Exchange Gateway.

Explanation: Insufficient memory to perform the current operation.

Possible Cause: The gateway server might have too many applications running.

Action: Stop some applications or move them to a different server.

Possible Cause: The gateway server might not meet the system memory requirements listed in 
Chapter 2, “Exchange Gateway System Requirements,” on page 13.

Action: Install additional memory.

Message server directories do not exist

Source: GroupWise Exchange Gateway.

Explanation: The MTA is not running or the gateway has not been configured on the 
GroupWise system.
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Action: Start the MTA for the domain that the gateway belongs to. See the appropriate 
section of the GroupWise 7 Installation Guide for the platform of your MTA:

“Starting the NetWare GroupWise Agents”
“Starting the Windows GroupWise Agents”

Action: Check the GroupWise configuration in ConsoleOne to ensure that the gateway 
object exists and is correctly configured. See Section 6.2, “Providing Gateway 
Information,” on page 52.

No active recipients while processing inbound message

Source: GroupWise Exchange Gateway.

Explanation: The gateway could not determine who to route the message to.

Possible Cause: The message might be damaged.

Action: Resend the message.

Possible Cause: The sender or recipient might not have access to the gateway.

Action: Verify that sender or recipient has access to the gateway. See Section 8.4, 
“Controlling Gateway Access,” on page 73.

No active recipients while processing outbound message

Source: GroupWise Exchange Gateway.

Explanation: The gateway could not determine who to route the message to.

Possible Cause: The message might be damaged.

Action: Resend the message.

Possible Cause: The sender or recipient might not have access to the gateway.

Action: Verify that sender or recipient has access to the gateway. See Section 8.4, 
“Controlling Gateway Access,” on page 73.

Unable to access the Microsoft Exchange gateway mailbox 

Source: GroupWise Exchange Gateway.

Explanation: The gateway is unable to access the mts-in or mts-out folder in the 
gateway’s Mailbox in the Exchange system during inbound or outbound 
message processing.

Action: Verify that all Exchange server services are running. See Chapter 5, 
“Configuring the Exchange Side of the Exchange Gateway,” on page 31.

Action: Verify that the user logged into Windows has enough rights to the Exchange 
system and the Mailbox store. See Chapter 5, “Configuring the Exchange Side 
of the Exchange Gateway,” on page 31.

Unable to add data to correlation record while processing inbound message

Source: GroupWise Exchange Gateway.

Explanation: The gateway cannot write to the correlation database (gwcorr.db).
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Possible Cause: There might not be enough disk space to perform the operation.

Action: Verify that there is enough free disk space to update the correlation database 
with new records.

Action: Make sure that the gateway server meets the disk space requirements listed in 
Chapter 2, “Exchange Gateway System Requirements,” on page 13.

Possible Cause: The correlation database might be damaged.

Action: Delete the corr.db file, then restart the gateway. This results in lost message 
status information but re-creates a valid correlation database. For more 
information, see Section 8.7, “Enabling Message Status for Sent Items,” on 
page 85.

Unable to commit correlation record while processing inbound message

Source: GroupWise Exchange Gateway.

Explanation: The gateway cannot write to the correlation database (gwcorr.db).

Possible Cause: There might not be enough disk space to perform the operation.

Action: Verify that there is enough free disk space to update the correlation database.

Action: Make sure that the gateway server meets the disk space requirements listed in 
Chapter 2, “Exchange Gateway System Requirements,” on page 13.

Possible Cause: The correlation database might be damaged.

Action: Delete the corr.db file, then restart the gateway. This results in lost message 
status information but re-creates a valid correlation database. For more 
information, see Section 8.7, “Enabling Message Status for Sent Items,” on 
page 85.

Unable to construct message while processing inbound message

Source: GroupWise Exchange Gateway.

Explanation: The gateway is unable to add a GroupWise field to the message.

Possible Cause: Insufficient memory to perform the operation.

Possible Cause: The gateway server might have too many applications running.

Action: Stop some applications or move them to a different server.

Possible Cause: The gateway server might not meet the system memory requirements listed in 
Chapter 2, “Exchange Gateway System Requirements,” on page 13.

Action: Install additional memory.

Unable to convert a directory field while performing an inbound directory operation

Source: GroupWise Exchange Gateway.

Explanation: The gateway encountered a damaged field during conversion.

Action: None. The field might not have been exchanged.
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Unable to convert attachment while processing inbound message

Source: GroupWise Exchange Gateway.

Explanation: The gateway failed to convert an attachment.

Possible Cause: The attachment might be damaged.

Action: Resend the message and attachment.

Possible Cause: There might not be enough disk space to perform the operation.

Action: Verify that there is enough free disk space to convert the attachment.

Action: Make sure that the gateway server meets the disk space requirements listed in 
Chapter 2, “Exchange Gateway System Requirements,” on page 13.

Unable to convert attachment while processing outbound message

Source: GroupWise Exchange Gateway.

Explanation: The gateway failed to convert an attachment.

Possible Cause: The attachment might be damaged.

Action: Resend the message and attachment.

Possible Cause: There might not be enough disk space to perform the operation.

Action: Verify that there is enough free disk space to convert the attachment.

Action: Make sure that the gateway server meets the disk space requirements listed in 
Chapter 2, “Exchange Gateway System Requirements,” on page 13.

Unable to convert message body while processing inbound message

Source: GroupWise Exchange Gateway.

Explanation: The gateway failed to convert an attachment.

Possible Cause: The attachment might be damaged.

Action: Resend the message and attachment.

Possible Cause: There might not be enough disk space to perform the operation.

Action: Verify that there is enough free disk space to convert the attachment.

Action: Make sure that the gateway server meets the disk space requirements listed in 
Chapter 2, “Exchange Gateway System Requirements,” on page 13.

Unable to create directory

Source: GroupWise Exchange Gateway.

Explanation: The directory could not be created during the installation because of transient 
network problems.

Action: Click Retry in the pop-up. 

Action: If the problem persists, manually reconnect to the server and try installing 
again.
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Unable to create correlation record while processing inbound message

Source: GroupWise Exchange Gateway.

Explanation: The gateway cannot write to the correlation database (gwcorr.db).

Possible Cause: There might not be enough disk space to perform the operation.

Action: Verify that there is enough free disk space to update the correlation database.

Action: Make sure that the gateway server meets the disk space requirements listed in 
Chapter 2, “Exchange Gateway System Requirements,” on page 13.

Possible Cause: The correlation database might be damaged.

Action: Delete the corr.db file, then restart the gateway. This results in lost message 
status information but re-creates a valid correlation database. For more 
information, see Section 8.7, “Enabling Message Status for Sent Items,” on 
page 85.

Unable to create gateway profile while initializing the gateway

Source: GroupWise Exchange Gateway.

Explanation: A profile with the same name might already exist.

Action: Restart the gateway so that a profile is created with a different name.

Unable to create message while processing inbound message

Source: GroupWise Exchange Gateway.

Explanation: The gateway cannot create a message file in its output queue.

Possible Cause: There might not be enough disk space to perform the operation.

Action: Verify that there is enough free disk space for the gateway to process message 
files in its queues (wpcsin and wpcsout).

Action: Make sure that the gateway server meets the disk space requirements listed in 
Chapter 2, “Exchange Gateway System Requirements,” on page 13.

Possible Cause: The gateway might not have sufficient access rights to the gateway’s wpcsin 
directory.

Action: Verify that the gateway has sufficient access rights to the MTA input queue in 
the domain.

Unable to find gateway root directory while performing an outbound directory 
operation

Source: GroupWise Exchange Gateway.

Explanation: The gateway root directory (domain\wpgate\exchange) could not be found.

Action: Use the /home startup switch to specify the gateway root directory correctly in 
the gwexch.cfg file, then start the gateway. See Section 7.1, “Starting the 
Exchange Gateway,” on page 55.

Unable to find inbound DLL while initializing the gateway

Source: GroupWise Exchange Gateway.
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Explanation: The gateway requires gwin.dll but is unable to find it.

Action: Add the domain\wpgate\exchange directory to the path variable on the 
server where the Gateway runs.

At the gateway server:

1 Right-click My Computer, then click Properties.
2 Click Environment.
3 In the User Variables for Administrator list, add the 

domain\wpgate\exchange directory to the end of the path variable 
value.

4 Click Set, then click OK.

Unable to find outbound DLL while initializing the gateway

Source: GroupWise Exchange Gateway.

Explanation: The gateway requires gwout.dll but is unable to find it.

Action: Add the domain\wpgate\exchange directory to the path variable on the 
server where the Gateway runs.

At the gateway server:

1 Right-click My Computer, then click Properties.
2 Click Environment.
3 In the User Variables for Administrator list, add the 

domain\wpgate\exchange to the end of the path variable value.
4 Click Set, then click OK.

Unable to find primary domain name while performing an inbound directory 
operation

Source: GroupWise Exchange Gateway.

Explanation: The gateway was unable to find primary domain information while trying to 
add or detect the foreign domain.

Possible Cause: The situation is rare and the problem might be due to internal database 
damage.

Action: None. 

Unable to generate accounting record while processing outbound message

Source: GroupWise Exchange Gateway.

Explanation: The gateway could not update the acct file.

Possible Cause: Insufficient memory to perform the operation.

Possible Cause: The gateway server might have too many applications running.

Action: Stop some applications or move them to a different server.
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Possible Cause: The gateway server might not meet the system memory requirements listed in 
Chapter 2, “Exchange Gateway System Requirements,” on page 13.

Action: Install additional memory.

Unable to generate status message while processing inbound message

Source: GroupWise Exchange Gateway.

Explanation: The gateway is unable to access the mts-in folder of the gateway mailbox in 
Microsoft Exchange.

Action: Verify that the Exchange server services are running. See Chapter 5, 
“Configuring the Exchange Side of the Exchange Gateway,” on page 31.

Unable to get configuration information from registry while initializing the gateway

Source: GroupWise Exchange Gateway.

Explanation: The gateway is unable to find the gateway’s Message Store in Exchange 5.5/
2000/2003.

Possible Cause: The Exchange server services might not be running.

Action: Verify that all Exchange server services are running. See Chapter 5, 
“Configuring the Exchange Side of the Exchange Gateway,” on page 31.

Possible Cause: The user logged into Windows with insufficient rights to the Exchange system 
and the Mailbox store.

Action: Verify that the user logged into Windows has enough rights to the Exchange 
system and the Mailbox store. See Chapter 5, “Configuring the Exchange Side 
of the Exchange Gateway,” on page 31.

For Exchange 5.5, the user logged into Windows should be a member of the 
Administrators, Domain Admins, and Domain Users groups and should have 
administrator permissions to the Exchange Organization, Site, and 
Configuration container property pages of the Exchange Server.

For Exchange 2000/2003, the user logged into Windows should be member of 
the Administrators, Domain Admins, and Enterprise Admins group and should 
have enough rights to the Exchange system. See Section 5.2, “Configuring 
Exchange 2000/2003,” on page 34.

Unable to get configuration information from Site Addressing object while 
initializing the gateway

Source: GroupWise Exchange Gateway.

Explanation: The Microsoft Exchange server services might not be running.

Action: Run the Microsoft Exchange server services as described in Chapter 5, 
“Configuring the Exchange Side of the Exchange Gateway,” on page 31, then 
restart the gateway.

Unable to get configuration information from the MAPI Session while initializing the 
gateway

Source: GroupWise Exchange Gateway.
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Explanation: The gateway is unable to find the gateway’s Message Store in Microsoft 
Exchange during initialization.

Possible Cause: The Exchange server services might not be running.

Action: Verify that all Exchange server services are running. See Chapter 5, 
“Configuring the Exchange Side of the Exchange Gateway,” on page 31.

Possible Cause: The user logged into Windows with insufficient rights to the Exchange system 
and the Mailbox store.

Action: Verify that the user logged into Windows has enough rights to the Exchange 
system and the Mailbox store. See Chapter 5, “Configuring the Exchange Side 
of the Exchange Gateway,” on page 31.

For Exchange 5.5, the user logged into Windows should be a member of the 
Administrators, Domain Admins, and Domain Users groups and should have 
administrator permissions to the Exchange Organization, Site, and 
Configuration container property pages of the Exchange Server.

For Exchange 2000/2003, the user logged into Windows should be member of 
the Administrators, Domain Admins, and Enterprise Admins group and should 
have enough rights to the Exchange system. See Section 5.2, “Configuring 
Exchange 2000/2003,” on page 34.

Unable to get MAPI Session while initializing the gateway

Source: GroupWise Exchange Gateway.

Explanation: Too many sessions have been opened simultaneously.

Action: Close unused sessions and restart the gateway.

Unable to locate gateway home directory

Source: GroupWise Exchange Gateway.

Explanation: The gateway home directory not defined.

Action: Run the gateway from the gateway home directory or specify the /home startup 
switch correctly in the gwexch.cfg file.

Unable to map recipients while processing outbound message

Source: GroupWise Exchange Gateway.

Explanation: The gateway cannot identify the Exchange recipients the message is being sent 
to.

Possible Cause: Insufficient memory to perform the operation.

Possible Cause: The gateway server might have too many applications running.

Action: Stop some applications or move them to a different server.

Possible Cause: The gateway server might not meet the system memory requirements listed in 
Chapter 2, “Exchange Gateway System Requirements,” on page 13.

Action: Install additional memory.
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Unable to obtain directory handle while initializing directory operations

Source: GroupWise Exchange Gateway.

Explanation: The gateway was unable to obtain a DAPI session.

Action: Check the application event log (Start > Programs > Administrative Tools > 
Event Viewer) for details of the problem.

Unable to obtain directory handle while performing an outbound directory operation

Source: GroupWise Exchange Gateway.

Explanation: The gateway was unable to obtain a DAPI session

Action: Check the application event log (Start > Programs > Administrative Tools > 
Event Viewer) for details. 

Unable to open the configuration file from the MAPI session

Source: GroupWise Exchange Gateway.

Explanation: The Exchange Gateway does not have sufficient rights to access the 
configuration file.

Action: Make sure that the Send As/Receive As rights on the Exchange message store 
are properly set, as described in Section 5.2, “Configuring Exchange 2000/
2003,” on page 34.

Unable to open the event log while initializing the gateway

Source: GroupWise Exchange Gateway.

Explanation: The EventLog service might not be running.

Action: Run the EventLog service and restart the gateway.

Unable to send Non-Delivery Report while processing inbound message

Source: GroupWise Exchange Gateway.

Explanation: The gateway is unable to access the mts-in folder in the gateway mailbox.

Action: Verify that the Microsoft Exchange server is running. See Chapter 5, 
“Configuring the Exchange Side of the Exchange Gateway,” on page 31.

Unable to set Microsoft Exchange message property while processing outbound 
message

Source: GroupWise Exchange Gateway.

Explanation: The gateway is unable to access the mts-in folder of the gateway mailbox in 
Microsoft Exchange.

Possible Cause: The Exchange server services might not be running.

Action: Verify that the Exchange server services are running. See Chapter 5, 
“Configuring the Exchange Side of the Exchange Gateway,” on page 31.

Possible Cause: Insufficient memory to perform the operation.

Possible Cause: The gateway server might have too many applications running.
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Action: Stop some applications or move them to a different server.

Possible Cause: The gateway server might not meet the system memory requirements listed in 
Chapter 2, “Exchange Gateway System Requirements,” on page 13.

Action: Install additional memory.

Undeliverable message while processing inbound message

Source: GroupWise Exchange Gateway.

Explanation: The GroupWise recipient address is invalid.

Action: Verify that the recipient exists in the GroupWise domain by looking up the 
user in the GroupWise Address Book.

Unknown message type while processing inbound message

Source: GroupWise Exchange Gateway.

Explanation: The gateway does not recognize the type of message file it has received from 
the Exchange system.

Possible Cause: The message file is damaged.

Action: Resend the message.

Possible Cause: The gateway is working with a Microsoft Exchange system version with which 
it is not compatible.

Action: See Chapter 2, “Exchange Gateway System Requirements,” on page 13 for a 
list of supported Exchange versions.

A.2  Informational Messages
“Processing <first name last name>” on page 132
“Processed XXX Exchange recipients” on page 133
“Number of Additions/Modifications: XXX” on page 133
“Number of Deletions: XXX” on page 133
“Number of Domains Allowed: XXX” on page 133
“Number of Domains Blocked: XXX” on page 133
“Number of Ignores: XXX” on page 133
“Total Number Processed: XXX” on page 133
“Some GroupWise records have not been written to the Exchange directory” on page 133
“Some Exchange objects have not been written to the GroupWise directory” on page 134

Processing <first name last name>

Source: GroupWise Exchange Gateway.

Explanation: The first name and last name of the object currently being processed during 
inbound directory exchange.
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Processed XXX Exchange recipients

Source: GroupWise Exchange Gateway.

Explanation: Status message that is displayed for every 50 Exchange recipients processed 
when the logging is set to Verbose mode.

Number of Additions/Modifications: XXX

Source: GroupWise Exchange Gateway.

Explanation: The number of additions or modifications processed during the current 
directory exchange operation.

Number of Deletions: XXX

Source: GroupWise Exchange Gateway.

Explanation: The number of deletions processed during the current directory exchange 
operation. For an inbound directory exchange operation, this includes all the 
tombstones that were processed, not necessarily the number of deletions made 
in the GroupWise Address Book.

Number of Domains Allowed: XXX

Source: GroupWise Exchange Gateway.

Explanation: This message appears if the /allowdom switch is in effect and valid domain 
names have been supplied. It provides statistics on the actual number of 
domains that were allowed during outbound directory exchange.

Number of Domains Blocked: XXX

Source: GroupWise Exchange Gateway.

Explanation: This message appears if the /blockdom switch is in effect and valid domain 
names have been supplied. It provides statistics on the actual number of 
domains that were blocked during outbound directory exchange.

Number of Ignores: XXX

Source: GroupWise Exchange Gateway.

Explanation: The number of ignored objects or records during the current directory 
exchange operation. For the inbound directory operation, all GroupWise 
custom recipients are ignored and for the outbound directory operation all 
foreign recipients under the Exchange foreign domain are ignored.

Total Number Processed: XXX

Source: GroupWise Exchange Gateway.

Explanation: The total number of records or objects obtained and processed during the 
current directory exchange operation.

Some GroupWise records have not been written to the Exchange directory

Source: GroupWise Exchange Gateway.
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Explanation: During the outbound directory operation, errors might have occurred which 
prevented all records obtained from being exchanged. This happens when the 
total of the additions, modifications, deletions, and ignores does not match the 
total number processed.

Some Exchange objects have not been written to the GroupWise directory

Source: GroupWise Exchange Gateway.

Explanation: During the inbound directory operation, errors might have occurred which 
prevented all objects obtained from being exchanged. This happens when the 
total of the additions, modifications, deletions, and ignores does not match the 
total number processed.
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BExchange Gateway Directory 
Structure

The following directory structure diagrams help you understand the Exchange Gateway:

Section B.1, “Exchange Server Directory Structure,” on page 135
Section B.2, “Exchange Gateway Directory Structure under the Domain,” on page 136

B.1  Exchange Server Directory Structure
When you run the Exchange Gateway, it adds a file to the Exchange installation directory.

B.1.1  exchsvr directory
The exchsvr directory is the standard directory to which Microsoft Exchange is installed on a 
server. On Windows NT, it is located at the root. On Windows 2000/2003, it is located in the 
Program Files directory. 

B.1.2  bin directory
The bin directory contains the Exchange server programs, some of which are used by the Exchange 
Gateway Installation program.

B.1.3  address directory
The address directory contains a subdirectory for each address type that defined in the Exchange 
system. In addition the GroupWise address type, address types include SNMP, cc:Mail, and X.400.

gwise\i386 directory

The gwise\i386 directory is where the Exchange Gateway Installation program installs the 
program that makes GroupWise users addressable in the Exchange system.

gwproxy.dll file

The gwproxy.dll file is the program that generates GroupWise-type addresses for all Exchange 
users.

 program files\exchsvr
 bin

Exchange Server installation directory
Subdirectory for Exchange server executables

address 
 gwise\i386

 gwproxy.dll

Subdirectory for addressing-related files
Subdirectory for files that support the GroupWise address type
Program that generates GroupWise addresses from Exchange 

addresses
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B.2  Exchange Gateway Directory Structure 
under the Domain
The Exchange Gateway is installed in a subdirectory of the domain it belongs to.

 domain\wpgate\exchange Exchange Gateway root directory

 000.prc
 cmd
 gwwork

 mmddlog.nnn
 proc

Directory for message processing
Not used in the current version of the Exchange Gateway
Working directory for processing messages
Exchange Gateway log files
Process lock file indicating that the Exchange Gateway is running

 gwhold
 qfiles

Directory for retaining delayed delivery messages
Not used in version 2.0 of the Exchange Gateway

 gwprob Directory for undeliverable incoming messages

 ds
 gwds

Directory for directory synchronization files
Directory synchronization file

 dx
 gwdx

Directory for directory exchange files
]Directory exchange file

 uninstexchange Directory for the Exchange Gateway uninstallation program

 wpcsin
 0-7

MTA input queue directory
Priority queue subdirectories

 wpcsout
 excxxxx

 0-7
 problem

MTA output queue directory
Exchange Gateway input queue
Priority queue subdirectories
Undeliverable messages

 api_in
 api_out

Input queue for free/busy requests from Exchange users
Output queue for free/busy responses going back to Exchange 

users

 readmeen.txt
 readmeen.html

Pointer Readme file in ASCII text format
Pointer Readme file in HTML format

 exgate.exe
 gwexch.cfg
 access.cfg
 gwcorr.*

Exchange Gateway program
Exchange Gateway startup file
Access control configuration file
Status message correlation database

 acct
 stat

Accounting file
Statistics file

 ngwexh.mib Exchange Gateway MIB file

 gwexgate.chm
 novell_ex.hs
 map.jhm
 *.htm

Windows help file for the Exchange Gateway server console
]JavaHelp helpset file for Gateway Administrator snap-in help
]Map file for Gateway Administrator snap-in help
]Help topics for Gateway Administrator snap-in help

 gwstrs.fil Exchange Gateway resource file
Wise 7 Gateway for Microsoft Exchange Installation and Administration Guide



novdocx (en)  16 A
pril 2010
B.2.1  domain\wpgate\exchange directory
The Exchange Gateway root directory is the default location for all Exchange Gateway files. During 
installation, you choose the domain where you want to install the Exchange Gateway and you 
choose the name of the root directory. The default directory name is exchange.

To improve performance if you installed the Exchange Gateway on a Windows server remote from 
the domain directory (for example, if the domain directory is located on a NetWare® server), you 
can move the queue directories from the domain directory to the Windows server where the gateway 
is running, as described in Section 10.4, “Reducing Network Traffic,” on page 106.

000.prc directory

The 000.prc directory is where the Exchange Gateway processes messages that are passing through 
the gateway between the GroupWise and Exchange systems.

mmddlog.nnn files

The mmddlog.nnn files are the Exchange Gateway log files where message routing information is 
recorded. See Section 9.3, “Using Exchange Gateway Log Files,” on page 98.

gwwork directory

The gwwork directory holds temporary files used in message processing.

gwhold directory

The gwhold directory is where delayed delivery messages are held until their delivery times arrive.

gwprob directory

The gwprob directory is where the Exchange Gateway places incoming message files that it cannot 
process. Using the /badmsg switch, you can configure the gateway to retain bad messages, delete 
bad messages, or send bad messages to the gateway postmaster. See Section 9.5, “Notifying the 
Exchange Gateway Administrator about Bad Messages,” on page 102.

ds directory

The ds directory helps the gateway keep track of whether or not directory synchronization has been 
performed.

gwds file

The gwds file indicates that directory synchronization has taken place. If you delete the gwds file 
and restart the gateway, the gateway performs directory synchronization immediately and then 
recreates the file.

dx directory

The dx directory helps the gateway keep track of whether or not directory exchange has been 
performed.

 *.dll Supporting Windows DLL programs
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gwdx file

The gwdx file indicates that directory exchange has taken place. If you delete the gwdx file and 
restart the gateway, the gateway performs directory exchange immediately and then recreates the 
file.

uninstexchange directory

The uninstexchange directory contains the Exchange Gateway uninstallation program and 
supporting files.

wpcsin directory

The wpcsin directory is the MTA input queue where the Exchange Gateway places messages from 
Exchange users for transfer into the GroupWise system. When a new message arrives, the MTA for 
the domain where the gateway is installed routes it to the appropriate destination. The wpcsin 
directory in the Exchange Gateway directory is parallel to the wpcsin directory in the domain. For 
more information, see:

“Domain Directory” in the GroupWise 7 Troubleshooting 3: Message Flow and Directory 
Structure
“Domain Directory” in the GroupWise 6.5 Troubleshooting 3: Message Flow and Directory 
Structure

The MTA input queue contains eight priority subdirectories.

0-7 priority directories

The 0-7 priority subdirectories in the MTA input queue handle different types of messages 
transferring from the Exchange system into the GroupWise system.

0:  Not used by the Exchange Gateway
1:  Not used by the Exchange Gateway
2:  High priority messages from Exchange users to GroupWise users
3:  Status messages notifying Exchange users about the status of high priority messages sent to 
GroupWise users
4:  Normal priority messages from Exchange users to GroupWise users
5:  Status messages notifying Exchange users about the status of normal priority messages sent 
to GroupWise users 
6:  Low priority messages from Exchange users to GroupWise users
7:  Status messages notifying Exchange users about the status of low priority messages sent to 
GroupWise users 

Status message correlation must be enabled in order for Exchange users to receive status 
information about messages sent to GroupWise users. See Section 8.7, “Enabling Message Status 
for Sent Items,” on page 85.

wpcsout directory

The wpcsout directory is the MTA output queue where the MTA for the domain where the gateway 
is installed places messages for transfer over to the Exchange system. 
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excxxxx directory

The excxxxx directory contains eight priority subdirectories.

0-7 priority directories The 0-7 priority subdirectories in the MTA output queue handle different 
types of messages transferring from the GroupWise system into the Exchange system.

0:  Busy searches from GroupWise users on Exchange users
1:  Not used by the Exchange Gateway
2:  High priority messages from GroupWise users to Exchange users
3:  Status messages notifying GroupWise users about the status of high priority messages sent 
to Exchange users 
4:  Normal priority messages from GroupWise users to Exchange users
5:  Status messages notifying GroupWise users about the status of normal priority messages 
sent to Exchange users 
6:  Low priority messages from GroupWise users to Exchange users
7:  Status messages notifying GroupWise users about the status of low priority messages sent 
to Exchange users 

Status message correlation must be enabled in order for GroupWise users to receive status 
information about messages sent to Exchange users. See Section 8.7, “Enabling Message Status for 
Sent Items,” on page 85.

problem directory

The problem directory is where the MTA places message files that it cannot deliver into one of the 
eight priority subdirectories, perhaps because the message files have been damaged.

api_in directory

The api_in directory is where the Microsoft Calendar Connector places free/busy requests from 
Exchange users. The Exchange Gateway picks up the free/busy requests and passes them into the 
GroupWise system so that GroupWise users’ Calendars can be checked for availability. For setup 
instructions, see Section 5.2.2, “Setting Up Bidirectional Busy Search for Exchange 2000/2003,” on 
page 39.

api_out directory

The api_out directory is where the Exchange Gateway places free/busy requests that have been 
checked against GroupWise users’ Calendars. The Microsoft Calendar Connector picks up the free/
busy requests and the associated GroupWise user Calendar information and passes them into the 
Exchange system so that Exchange users are able to obtain GroupWise users’ availability 
information. For setup instructions, see Section 5.2.2, “Setting Up Bidirectional Busy Search for 
Exchange 2000/2003,” on page 39.

readmeen.txt file

The readmeen.txt file lists sources of documentation for the GroupWise 7 Gateway for Microsoft 
Exchange on the GroupWise Gateways Documentation Web site (http://www.novell.com/
documentation/gwgateways).
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readmeen.html file

The readmeen.txt file lists sources of documentation for the GroupWise 7 Gateway for Microsoft 
Exchange on the GroupWise Gateways Documentation Web site (http://www.novell.com/
documentation/gwgateways).

exgate.exe file

The exgate.exe file is the Exchange Gateway executable file. You run this program to start the 
Exchange Gateway. See Section 7.1, “Starting the Exchange Gateway,” on page 55.

gwexch.cfg file

The gwexch.cfg file is the Exchange Gateway startup file where you can use startup switches to 
configure the Exchange Gateway. See Chapter 11, “Using Exchange Gateway Startup Switches,” on 
page 107.

access.cfg file

The access.cfg file is the Exchange Gateway access control file where you can control access 
through the gateway. See Section 8.4, “Controlling Gateway Access,” on page 73.

acct file

The acct file is the accounting file where information about messages passing through the gateway 
is recorded. See Section 8.5, “Setting Up Accounting,” on page 81.

stat file

The stat file is the gateway statistics file that contains the statistics information displayed on the 
Exchange Gateway server console. See Section 9.1, “Using the Exchange Gateway Server 
Console,” on page 89.

gwcorr.* files

The gwcorr.db file is the message status correlation database that enables message status 
information to be exchanged between GroupWise users and Exchange users. See Section 8.7, 
“Enabling Message Status for Sent Items,” on page 85.

The gwcorr.dc file is the data dictionary file from which the gwcorr.db file is created.

ngwexh.mib file

The ngwexh.mib file is used if you configure the Exchange Gateway for SNMP. See Section 9.4, 
“Using SNMP Monitoring Programs,” on page 99.

gwexgate.chm file

The gwexgate.chm file is the Windows help file that is available from the Exchange Gateway 
server console.
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novell_ex.hs file

The novell_ex.hs file is the JavaHelp helpset file for the Exchange Gateway help available in 
ConsoleOne. 

map.jhm file

The map.jhm file is the JavaHelp map file that maps contexts to Exchange Gateway help topics in 
ConsoleOne.

*.htm files

The *.htm files are the Exchange Gateway help topics that are available in ConsoleOne.

gwstrs.fil file

The gwtrs.fil file is the strings resource file used by the Exchange Gateway server console on the 
Windows server where the gateway runs.

*.dll files

The *.dll files are supporting programs that provide specialized functionality to the Exchange 
Gateway.
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This section lists updates to the GroupWise 7 Gateway for Microsoft Exchange Installation and 
Administration Guide that have been made since the initial release of the gateway. The information 
helps you to keep current on documentation updates and, in some cases, software updates (such as a 
Support Pack release).

The information is grouped according to the date when the GroupWise 7 Gateway for Microsoft 
Exchange Installation and Administration Guide was republished. Within each dated section, the 
updates are listed by the names of the main table of contents sections.

The GroupWise 7 Gateway for Microsoft Exchange Installation and Administration Guide has been 
updated on the following dates:

Section C.1, “August 24, 2010 (Doc update),” on page 143
Section C.2, “May 8, 2007 (Exchange Gateway SP2),” on page 144
Section C.3, “January 24, 2007 (Exchange Gateway SP1),” on page 144

C.1  August 24, 2010 (Doc update)

Location Change

Chapter 1, “What Is the 
GroupWise Gateway for 
Microsoft Exchange?,” on 
page 11

Linked to Exchange Gateway Best Practices by consultant Ed Hanley for 
additional architectural information.

Chapter 2, “Exchange 
Gateway System 
Requirements,” on page 13

Clarified that the GroupWise 7 Gateway for Microsoft Exchange can be 
used with a GroupWise 8 system; clarified that the GroupWise 7 Gateway 
for Microsoft Exchange is not yet supported on Exchange 2007. However, 
it can be set up successfully on an intermediate Exchange 2003 server 
between Exchange 2007 and GroupWise. 

Section 3.2, “Deciding 
Where to Install the 
Exchange Gateway,” on 
page 15

Added a recommendation to create a new Exchange server and 
GroupWise domain specifically for servicing the Exchange Gateway.

Section 4.1, “Meeting 
Installation Prerequisites,” 
on page 25

Clarified that the Novell Client is required only on the Exchange server 
where the Exchange Gateway is installed.

Section 3.9, “Determining 
Where to Install the 
Exchange Gateway 
Administrator Snap-In to 
ConsoleOne,” on page 20 
and Section 4.5, “Installing 
the Exchange Gateway 
Administrator Snap-In to 
ConsoleOne,” on page 29

Corrected the acceptable locations for installing the Exchange Gateway 
snap-in to ConsoleOne.
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C.2  May 8, 2007 (Exchange Gateway SP2)

C.3  January 24, 2007 (Exchange Gateway SP1)

Chapter 11, “Using 
Exchange Gateway Startup 
Switches,” on page 107

Linked to Exchange Gateway Best Practices by consultant Ed Hanley for 
information about currently undocumented switches.

“/custom” on page 110 Clarified the behavior of this startup switch.

“/useimportcontainer” on 
page 116

Clarified the behavior of this startup switch.

Location Change

/displaynamelastfirst Added a new startup switch

/noreadreceipt Added a new startup switch

/useimportcontainer Added a new startup switch

Location Change

Section 3.2, “Deciding 
Where to Install the 
Exchange Gateway,” on 
page 15

Explained how the Exchange Gateway can be set up in the context of 
Linux servers.

Section 4.2, “Adding the 
Exchange Library Directory 
to the Path Variable,” on 
page 26

Clarified that you need to add the Exchange library directory to the path 
variable only when Exchange is installed in a non-default location.

Section 5.2.2, “Setting Up 
Bidirectional Busy Search 
for Exchange 2000/2003,” 
on page 39

Added the configuration steps so that Busy Search works both ways 
between GroupWise and Exchange.

Section 8.1, “Enabling 
Directory Synchronization 
and Exchange of Address 
Books,” on page 61

Added instructions for overriding the default Internet domain name and 
e-mail address format when exchanging address books.

Section 9.1.5, “Menu 
Summary,” on page 91

Added Synchronize Directories under F8 on the gateway server 
console menu.

“/importsubcontainers” on 
page 112

Added a new startup switch.

Location Change
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Section B.2, “Exchange 
Gateway Directory Structure 
under the Domain,” on 
page 136

Added the api_in and api_out subdirectories that are used for 
bidirectional Busy Search.

Location Change
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